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Welcome to Contract Tools

Contract Tools is a powerful Word add-in for drafting and
analyzing contracts.

To learn how to get started with Contract Tools, see Chapter 1, “Getting Started” on the next
page.

Note: This user guide is not intended to be a guide to drafting contracts, provide legal advice, or
create an attorney-client relationship. This user guide, and Contract Tools itself, cannot
substitute for the advice of an attorney. You should consult an attorney before you enter into
any contract.
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Chapter 1

Getting Started

Install Contract Tools. Get a free trial. Activate Contract Tools
using an activation key. Connect to your organization’s license
server. Enable Contract Tools in Word. Get a tutorial. Update
Contract Tools. Learn about Contract Tools’ prerequisites.

To learn about Go to

Step-by-step instructions for installing Contract
Tools

Section 1.1, “Installing Contract Tools” on the next
page

Starting a free trial of Contract Tools Section 1.2, “Trying Contract Tools” on the next page

Using an activation key Section 1.3, “Activating Contract Tools” on page 8

Trying and activating Contract Tools on virtual
machines

Section 1.4, “Using Contract Tools on a Virtual
Machine” on page 9

Connecting to your organization’s license server Section 1.5, “Connecting to Contract Tools License
Server” on page 10

Using Contract Tools when Word requires add-ins
to be signed by a trusted publisher

Section 1.6, “Adding Paper Software as a Trusted
Publisher” on page 10

Enabling Contract Tools in Word Section 1.7, “Enabling Contract Tools” on page 11

Getting a tutorial of Contract Tools Section 1.8, “The Contract Tools Tutorial” on
page 11

Getting updates to Contract Tools Section 1.9, “Updating Contract Tools” on page 11

Contract Tools’ requirements Section 1.10, “Prerequisites for Installing Contract
Tools” on page 12
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1.1 Installing Contract Tools
To install Contract Tools, you need PaperSoftwareContractToolsSetup.exe (available at
https://papersoftware.com/support).

You may need an administrator account to install Contract Tools.

To install Contract Tools:

1. Find PaperSoftwareContractToolsSetup.exe on your computer, and then double-click it to open
Contract Tools Setup.

2. When Contract Tools Setup is finished, click Finish.

Note: On computers with Word 2007, you must install Contract Tools only for you, not for
everyone who uses your computer. To do this, choose “Only me ([Your User Name])”, not
“Everyone who uses this computer”, in the Installation Type dialog of Contract Tools Setup.

When you install Contract Tools, you also install Contract Tools’ prerequisites; see Section 1.10,
“Prerequisites for Installing Contract Tools” on page 12 to learn more.

After you install Contract Tools, you can try it for free for 7 days; see Section 1.2, “Trying
Contract Tools” on this page to learn more.

If you have a Contract Tools subscription, you can activate Contract Tools using your activation
key; see Section 1.3, “Activating Contract Tools” on the next page to learn more.

When you open Word after installing Contract Tools, this alert message may appear: “The
solution cannot be installed because it is signed by a publisher whom you have not yet chosen
to trust. If you trust the publisher, add the certificate to the Trusted Publisher List.” To learn how
to add Paper Software to your list of trusted publishers, see Section 1.6, “Adding Paper Software
as a Trusted Publisher” on page 10.

You may need to enable Contract Tools in Word; see Section 1.7, “Enabling Contract Tools” on
page 11 to learn how.

To learn how to uninstall Contract Tools, see Section 15.4, “Uninstalling Contract Tools” on
page 59.

To troubleshoot problems with installing Contract Tools, see Section 16.1, “Contract Tools
Setup Won’t Download Prerequisites” on page 61 and Section 16.2, “Program Compatibility
Assistant Appears after Installing Contract Tools” on page 62.

1.2 Trying Contract Tools
After installing Contract Tools (see Section 1.1, “Installing Contract Tools” on this page to learn
more), you can try it for free for 7 days.

To begin a trial of Contract Tools:

1. Open a document or create a new document in Word. The Contract Tools pane appears next to
your document.

2. Click Begin Trial in the Contract Tools pane.

Note: Once you begin a trial, it cannot be suspended.
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After your trial, you can keep using Contract Tools by entering the activation key you receive
when you buy a subscription. To buy a Contract Tools subscription, visit
https://papersoftware.com. To learn about activating Contract Tools with an activation key, see
Section 1.3, “Activating Contract Tools” on this page.

Trying Contract Tools requires real hardware, not a virtual machine; see Section 1.4, “Using
Contract Tools on a Virtual Machine” on the next page to learn more.

To troubleshoot problems with beginning a trial, see Section 16.7, “Contract Tools Cannot
Connect to the Internet” on page 65, Section 16.8, “Contract Tools Won’t Activate Due to
Disabled Network Adapters” on page 66, and Section 16.9, “Contract Tools Won’t Activate Due
to a Problem with Windows Management Instrumentation” on page 66.

1.3 Activating Contract Tools
To use Contract Tools after your trial (see Section 1.2, “Trying Contract Tools” on the previous
page to learn more), you need the activation key you receive when you buy a subscription. To
buy a Contract Tools subscription, visit https://papersoftware.com. To recover an activation
key, visit https://papersoftware.com/activation.

To learn about Go to

Activating Contract Tools by sending your
activation key over the internet

Section 1.3.1, “Activating Online” on this page

An alternative to sending your activation key over
the internet

Section 1.3.2, “Activating Offline” on the next page

Activating Contract Tools requires real hardware, not a virtual machine; see Section 1.4, “Using
Contract Tools on a Virtual Machine” on the next page to learn more.

If your organization uses Contract Tools License Server to administer Contract Tools, you can
connect Contract Tools to Contract Tools License Server instead of activating it. See Section 1.5,
“Connecting to Contract Tools License Server” on page 10 to learn more.

You can use your activation key to activate Contract Tools on one computer at a time. If you
want to activate Contract Tools on a different computer, you should first deactivate Contract
Tools on your current computer. Also, if Contract Tools is already activated using one activation
key, and you want to activate Contract Tools using a different activation key, you must first
deactivate Contract Tools. To learn how to deactivate Contract Tools, see Section 15.1,
“Deactivating Contract Tools” on page 57.

To troubleshoot problems with activating Contract Tools, see Section 16.7, “Contract Tools
Cannot Connect to the Internet” on page 65, Section 16.8, “Contract Tools Won’t Activate Due
to Disabled Network Adapters” on page 66, and Section 16.9, “Contract Tools Won’t Activate
Due to a Problem with Windows Management Instrumentation” on page 66.

1.3.1 Activating Online
Generally, you activate Contract Tools by sending your activation key over the internet.

To activate Contract Tools online:

1. Open a document or create a new document in Word. The Contract Tools pane appears next to
your document.
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2. Enter your activation key in the Contract Tools pane, and then click Activate.

1.3.2 Activating Offline
If you cannot activate Contract Tools online, you can activate Contract Tools offline. When you
activate Contract Tools offline, you save a request file, upload this request file at
https://papersoftware.com/offline-activation to get a response file, and then activate Contract
Tools by opening the response file.

To activate Contract Tools offline:

1. Open a document or create a new document in Word. The Contract Tools pane appears next to
your document.

2. Choose Activate Offline from the pop-up menu at the top of the Contract Tools pane.

3. Enter your activation key, and then click Save Request File. Choose where you want to save the
request file, and then click Save.

4. Visit https://papersoftware.com/offline-activation and upload the request file to get a
response file.

5. Click Open Response File. Find the response file on your computer, select it, and then click
Open.

You can use a response file only once. If you need to activate Contract Tools offline again, follow
the steps listed above to get another response file. It’s OK to delete the request file and
response file after you’ve activated Contract Tools.

Note: You cannot deactivate Contract Tools offline; see Section 15.1, “Deactivating Contract
Tools” on page 57 to learn how to deactivate Contract Tools.

1.4 Using Contract Tools on a Virtual Machine
To activate or begin a trial of Contract Tools, Windows, Word, and Contract Tools must be
installed on real hardware, not on a virtual machine. Examples of virtual machine software
include Citrix Virtual Apps and Desktops, Microsoft 365 Defender, Parallels Desktop, Remote
Desktop Services, VMware Fusion, Windows 365, Windows Sandbox, and Windows Virtual
Desktop.

If you believe you’re using real hardware, but an alert message about virtual machines appears
when you try to activate or begin a trial of Contract Tools, make sure that Windows
virtualization features are disabled. Examples of Windows virtualization features include
Hyper-V Platform, Memory Integrity, Virtual Machine Platform, Windows Defender Application
Guard, and Windows Hypervisor Platform. If disabling Windows virtualization features doesn’t
resolve the issue, make sure that virtualization is disabled on your computer’s processor; your
computer’s documentation should have instructions on how to disable virtualization on your
computer’s processor.

If you need to use Contract Tools on a virtual machine, email info@papersoftware.com to learn
about deployment options.

To learn about trying Contract Tools, see Section 1.2, “Trying Contract Tools” on page 7. To learn
about activating Contract Tools, see Section 1.3, “Activating Contract Tools” on the previous
page. To learn about other Contract Tools prerequisites, see Section 1.10, “Prerequisites for
Installing Contract Tools” on page 12.
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1.5 Connecting to Contract Tools License Server
If your organization uses Contract Tools License Server to administer Contract Tools, you can
start using Contract Tools by connecting to your organization’s license server.

To connect Contract Tools to Contract Tools License Server:

1. Open a document or create a new document in Word. The Contract Tools pane appears next to
your document.

2. Choose “Connect to License Server” from the pop-up menu at the top of the Contract Tools
pane.

3. Enter the address and port of your organization’s license server. Your system administrator can
provide the address and port that you should use.

4. Click Connect.

If a message that says “Contract Tools cannot connect to your organization’s license server”
appears at the top of the Contract Tools pane, see Section 16.10, “Contract Tools Cannot
Connect to a License Server” on page 67.

To learn how to disconnect from Contract Tools License Server, see Section 15.2,
“Disconnecting from Contract Tools License Server” on page 58.

1.6 Adding Paper Software as a Trusted Publisher
Word may require add-ins like Contract Tools to be signed by a trusted publisher. To check this,
choose File > Options > Trust Center, click Trust Center Settings to show the Trust Center dialog,
click Add-ins on the left of the Trust Center dialog, and then check whether the “Require
Application Add-ins to be signed by Trusted Publisher” checkbox is selected.

To use Contract Tools when Word requires add-ins to be signed by a trusted publisher, you
must add Paper Software to your list of trusted publishers.

To add Paper Software to your list of trusted publishers:

1. Right-click PaperSoftwareContractToolsSetup.exe (visit https://papersoftware.com/support to
download this file), and then choose Properties.

2. Click Digital Signatures at the top of the Properties window.

3. Select Paper Software LLC in the signature list, and then click Details.

4. Click View Certificate in the Digital Signature Details window.

5. Click Install Certificate in the Certificate window.

6. In Windows 8.1 and later, choose Current User. Click Next.

7. Choose “Place all certificates in the following store”, and then click Browse.

8. Select Trusted Publishers in the Select Certificate Store window, and then click OK.

9. Click Next, and then click Finish.

After you add Paper Software to your list of trusted publishers, you may need to enable Contract
Tools in Word; see Section 1.7, “Enabling Contract Tools” on the next page to learn how.
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1.7 Enabling Contract Tools
You may need to enable Contract Tools in Word before you can use it. To enable add-ins in
Word, you use the Add-ins pane of Word Options. To show the Add-ins pane, choose File >
Options > Add-ins. Contract Tools appears as Paper Software Contract Tools in the Add-ins
pane.

To enable Contract Tools when it appears below Inactive Application Add-ins:

1. Choose COM Add-ins from the Manage pop-up menu at the bottom of the Add-ins pane, and
then click Go. The COM Add-ins dialog appears.

2. Select the Paper Software Contract Tools checkbox, and then click OK.

To enable Contract Tools when it appears below Disabled Application Add-ins:

1. Choose Disabled Items from the Manage pop-up menu at the bottom of the Add-ins pane, and
then click Go. The Disabled Items dialog appears.

2. Select Paper Software Contract Tools, and then click Enable.

Note: If you cannot enable Contract Tools in Word 2007, make sure that Contract Tools is
installed only for you, not for everyone who uses your computer. A simple way to do this is to
uninstall and reinstall Contract Tools; see Section 15.4, “Uninstalling Contract Tools” on page 59
and Section 1.1, “Installing Contract Tools” on page 7 to learn how.

1.8 The Contract Tools Tutorial
You can use the Contract Tools Tutorial (Contract Tools Tutorial.rtf) to learn how to use
Contract Tools. To download the Contract Tools Tutorial, visit
https://papersoftware.com/support.

Note:When you open the Contract Tools Tutorial in Word, it may open in Protected View. You
cannot use Contract Tools in Protected View. To exit Protected View, click Enable Editing at the
top of the Word window. If Contract Tools is turned off, click Contract Tools at the top of the
Word window to show the Contract Tools ribbon tab, and then click the On / Off button to turn
on Contract Tools. To learn about Protected View, search for “protected view” in Word Help.

1.9 Updating Contract Tools
By default, Contract Tools automatically checks for updates. To turn this off, show the Contract
Tools pane, click the Subscription button, and then deselect the “Automatically check for
updates” checkbox.

Whether Contract Tools can automatically check for updates depends on how your computer
and network are configured. If Contract Tools isn’t updating automatically, you can update
Contract Tools manually.

Here are ways to update Contract Tools manually:

• Show the Contract Tools pane, click the Subscription button, and then click “Check for
Updates”. If more than one update is available, you can install only the latest update and skip
the others. To skip an update, deselect the checkbox next to the update in the “Found Updates
for Contract Tools” dialog.
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• Use PaperSoftwareContractToolsSetup.exe (available at https://papersoftware.com/support)
to install the latest version of Contract Tools; see Section 1.1, “Installing Contract Tools” on
page 7 to learn how.

To troubleshoot problems with updating Contract Tools, see Section 16.20, “Contract Tools
Won’t Install Updates” on page 72.

1.10 Prerequisites for Installing Contract Tools
On all computers, Contract Tools requires Windows 7 or later, Word 2007 or later, and Visual
Studio 2010 Tools for Office Runtime.

On computers with Windows 7 and 8.1, Contract Tools requires .NET Framework with a
version between 4.5.2 and 4.8. On computers with Word 2007, Contract Tools also requires
.NET Framework 3.5.

To download an installer for this Visit

Visual Studio 2010 Tools for Office Runtime https://www.microsoft.com/en-us/download/
details.aspx?id=105890

.NET Framework 4.5.2 https://www.microsoft.com/en-us/download/
details.aspx?id=42643

.NET Framework 3.5 https://www.microsoft.com/en-us/download/
details.aspx?id=21

By default, when you install Contract Tools (see Section 1.1, “Installing Contract Tools” on
page 7), you also install Contract Tools’ prerequisites, so you shouldn’t need to download the
installers listed above. To troubleshoot problems with installing Contract Tools’ prerequisites,
see Section 16.1, “Contract Tools Setup Won’t Download Prerequisites” on page 61.

Activating and beginning a trial of Contract Tools require real hardware, not a virtual machine;
see Section 1.4, “Using Contract Tools on a Virtual Machine” on page 9 to learn more.
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Chapter 2

Tools and Techniques

Turn Contract Tools on or off. Navigate your document. Go back in
navigation history. Highlight text. Complete defined terms and
snippets. Copy and paste content. Use the Context button to do
common tasks. Use the Issues pop-up menu to find problems.

To learn about Go to

Turning Contract Tools on and off; showing and
hiding the Contract Tools pane

Section 2.1, “The Contract Tools Ribbon Tab” on this
page

Navigating your document Section 2.2, “Navigating Documents” on the next
page

Highlighting defined terms, cross-references,
drafting errors, list markers, and more

Section 2.3, “Highlighting Content” on page 15

Completing defined terms and snippets as you type Section 2.4, “The Completion Menu” on page 16

The Context button; the Previous and Next buttons;
views within the Contract Tools pane; the Issues
pop-up menu

Section 2.5, “The Contract Tools Pane” on page 16

2.1 The Contract Tools Ribbon Tab
You can use the buttons in the Contract Tools ribbon tab to turn Contract Tools on or off, show
or hide the Contract Tools pane, and more. To show the Contract Tools ribbon tab, click
Contract Tools at the top of the Word window.

Turn Contract
Tools on or off.

Analyze your
document.

Go back or forward
in navigation history;
clear history.

Show the Contract
Tools pane.

Open Contract
Tools Help.
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On / Off: Click the On / Off button to turn Contract Tools on or off. You can choose whether
Contract Tools is on or off when you open documents; see Chapter 14, “Setting Preferences” on
page 56 to learn how.

Analyze: Click the Analyze button to update Contract Tools’ analysis; see Section 3.2, “Updating
Analysis” on page 22 to learn more. To learn general information about analysis, see Chapter 3,
“Analyzing Documents” on page 21.

History: Click the Back and Forward buttons to go back or forward in navigation history, and
click the Clear button to remove all items from navigation history. You can also use the Back
and Forward buttons in the Contract Tools pane; see Section 2.2, “Navigating Documents” on
this page to learn more.

Contract Tools Pane: Click the Contract Tools Pane button to show or hide the Contract Tools
pane, and click one of the other buttons to show a Contract Tools pane view; see Section 2.5,
“The Contract Tools Pane” on page 16 to learn more.

Help: Click the Help button to open Contract Tools Help. For more resources, visit
https://papersoftware.com/support.

2.2 Navigating Documents
You can use a variety of tools and techniques to navigate your document.

See where you’ve
scrolled when you
drag the vertical
scroller.

Double-click a
cross-reference to
go to what it
references.

Double-click a use
of a defined term
to go to where it’s
defined.

Go back or forward
in navigation history.

Navigate defined terms
and cross-references;
see where you are.

Go to items that
are simlar to one
you select.

Scrolling: When you drag the vertical scroller, the name of the part of the document to which
you’ve scrolled appears at the bottom of the Word window. To stop this information from
appearing, show the Contract Tools pane, click the Preferences button, and then deselect the
“Show location when dragging vertical scroller” checkbox.
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Double-clicking: When you double-click a use of a defined term (see Chapter 5, “Working with
Defined Terms” on page 28 to learn more), you go to where it’s defined. When you double-click
a cross-reference (see Chapter 6, “Working with Cross-References” on page 32 to learn more),
you go to what it references. When you set the insertion point (cursor) within text you can
navigate by double-clicking, it’s highlighted in blue; see Section 2.3, “Highlighting Content” on
this page to learn more. To turn off navigation by double-clicking, show the Contract Tools
pane, click the Preferences button, and then deselect the “Double-click defined terms and
cross-references to navigate” checkbox. Navigation by double-clicking does not change your
document in any way.

Back and Forward buttons: Click the Back and Forward buttons at the top left of the Contract
Tools pane to return to items to which you’ve navigated. You can also use the Back and
Forward buttons in the Contract Tools ribbon tab; see Section 2.1, “The Contract Tools Ribbon
Tab” on page 13 to learn more.

Context button, Previous and Next buttons: You can use the Context button at the top of the
Contract Tools pane to navigate selected defined terms and cross-references, see the name of
the part of the document you’re working with, and more. You can use the Previous and Next
buttons at the top right of the Contract Tools pane to go to items that are similar to one you
select. See Section 2.5.1, “The Context Button; the Previous and Next Buttons” on page 17 to
learn more.

To learn more about the Contract Tools pane, see Section 2.5, “The Contract Tools Pane” on the
next page.

2.3 Highlighting Content
Contract Tools highlights many items in your document. Some items are highlighted depending
on what you select. You can select an item by clicking or by setting the insertion point (cursor)
using the arrow keys.

When you select this This is highlighted To learn more, go to

Defined term
Instances of the defined term

Chapter 5, “Working with Defined
Terms” on page 28

Cross-reference
Cross-references to the same item

Chapter 6, “Working with
Cross-References” on page 32

Placeholder
Other placeholders

Chapter 9, “Finding To-Dos” on
page 43

Ancillary
Other ancillaries

Chapter 10, “Working with
Ancillaries” on page 45

Inline list, proviso list
List markers

Chapter 11, “Working with Inline
Lists and Proviso Lists” on page 47

Amount of money, duration,
date, time of day Similar items

Section 12.2, “Finding Numbers,
Amounts of Money, and Dates and
Times” on page 49
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When you select this This is highlighted To learn more, go to

Parenthesis
Matching parentheses

—

Other items are always highlighted, even if they’re not selected:

• Drafting errors (see Chapter 8, “Proofreading Documents” on page 36)

• Search results (see Chapter 12, “Finding Text” on page 48)

To hide highlighting, or to use underlining instead of highlighting, show the Contract Tools
pane, click the Preferences button, and then use the Highlighting & Underlining controls.

Note: Highlighting and underlining do not change your document in any way.

In addition to highlighting items you select, you can use the Context button and the Previous
and Next buttons to work with items you select; see Section 2.5.1, “The Context Button; the
Previous and Next Buttons” on the next page to learn how.

To troubleshoot problems with highlighting appearing in the wrong place, see Section 16.6,
“The Contract Tools Pane Appears with Black Shapes; Highlighting Is Misplaced” on page 64.

2.4 The Completion Menu
You can use the Completion menu to insert uses of defined terms (see Chapter 5, “Working with
Defined Terms” on page 28) and snippets (see Chapter 13, “Working with Snippets” on page 53)
into your document. When you start typing a use of a defined term or the name of a snippet,
the Completion menu appears with a list of suggestions. You can continue typing to refine or
ignore the suggestions. To choose a suggestion, use the Up Arrow and Down Arrow keys to
select it, and then press the Right Arrow key. You can also choose a suggestion by clicking it.

To set Completion menu preferences, show the Contract Tools pane, click the Preferences
button, and then use the Completion Menu controls.

2.5 The Contract Tools Pane
You can use the Contract Tools pane to do a variety of tasks. To show the Contract Tools pane,
click the Contract Tools Pane button in the Contract Tools ribbon tab; see Section 2.1, “The
Contract Tools Ribbon Tab” on page 13 to learn more.

To learn about Go to

Performing actions and navigating based on an
item you select

Section 2.5.1, “The Context Button; the Previous
and Next Buttons” on the next page

Views within the Contract Tools pane Section 2.5.2, “Contract Tools Pane Views” on
page 18

Using the contents of views to share or create
content

Section 2.5.3, “Copying and Pasting the Contents of
Views” on page 18

Viewing a list of potential problems Section 2.5.4, “The Issues Pop-Up Menu” on page 19
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To learn about Go to

Updating information in the Contract Tools pane Section 2.5.5, “The Analyze Button” on page 20

To troubleshoot problems with the Contract Tools pane, see Section 16.5, “The Contract Tools
Pane Won’t Appear” on page 64 and Section 16.6, “The Contract Tools Pane Appears with Black
Shapes; Highlighting Is Misplaced” on page 64.

2.5.1 The Context Button; the Previous and Next Buttons
The Context button and the Previous and Next buttons appear at the top of the Contract Tools
pane. What these buttons do depends on what you select in your document. You can select an
item in your document by clicking or by setting the insertion point (cursor) using the arrow keys.

When you select
this

You can use the Context button
to do this

And the Previous
and Next buttons
to go to this

To learn more, go to

Defined term
Go to where it’s defined, show
where it’s defined in a new
window, show it in the Defined
Terms view

Instances of the
defined term

Chapter 5, “Working with
Defined Terms” on
page 28

Cross-reference
Convert it to a field, go to what it
refers to, show what it refers to in
a new window, show it in the
Cross-References view

Cross-references to
the same item

Chapter 6, “Working with
Cross-References” on
page 32

Drafting error
Ignore it, show it in the Drafting
Errors view, undo ignoring

Instances of the
same kind of
drafting error

Chapter 8, “Proofreading
Documents” on page 36

Placeholder
Show it in the To-Dos view Other placeholders

Chapter 9, “Finding
To-Dos” on page 43

Ancillary
Show it in the Ancillaries view Other ancillaries

Chapter 10, “Working
with Ancillaries” on
page 45

Amount of money,
duration, date, time
of day

Find similar items in the Search
view

Similar items Section 12.2, “Finding
Numbers, Amounts of
Money, and Dates and
Times” on page 49

Other text See the name of the part of the
document you’ve selected

— —

When you can do more than one action with a selection, an arrow appears to the right of the
Context button, and you can click the arrow to choose an action.

In addition to using the Context button and the Previous and Next buttons to work with items
you select, you can highlight items based on what you select; see Section 2.3, “Highlighting
Content” on page 15 to learn more.
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2.5.2 Contract Tools Pane Views

You can use views in the Contract Tools pane to navigate provisions, find defined terms,
manage drafting errors, search for words and phrases, and more.

Here are ways to show views in the Contract Tools pane:

• Click one of the buttons at the top of the Contract Tools pane. From left to right, these buttons
show these views: Provisions, Defined Terms, Cross-References, Related Items, Drafting Errors,
To-Dos, Ancillaries, Search, Snippets, Analysis Settings, Preferences, and Subscription.

Click a button to show a view.

• Use the buttons in the Contract Tools ribbon tab; see Section 2.1, “The Contract Tools Ribbon
Tab” on page 13 to learn more.

• To show a second view, click the arrow at the bottom right of the Contract Tools pane.

As you work with views in the Contract Tools pane, you may want to switch back to your
document using your keyboard instead of your mouse or trackpad. To do this, press the Esc
(Escape) key.

To learn about this view Go to

Provisions Section 4.2, “Managing Provisions” on page 26

Defined Terms Section 5.3, “Managing Defined Terms” on page 30

Cross-References Section 6.2, “Managing Cross-References” on page 32

Related Items Chapter 7, “Finding Related Items” on page 35

Drafting Errors Section 8.3, “Managing Drafting Errors” on page 41

To-Dos Chapter 9, “Finding To-Dos” on page 43

Ancillaries Chapter 10, “Working with Ancillaries” on page 45

Search Chapter 12, “Finding Text” on page 48

Snippets Chapter 13, “Working with Snippets” on page 53

Analysis Settings Section 3.4, “Saving Analysis Settings” on page 23
Section 3.6, “Analyzing Tables” on page 25
Section 5.1, “Finding Defined Terms” on page 28
Section 8.1, “Checking for Drafting Errors” on page 36

Preferences Chapter 14, “Setting Preferences” on page 56

Subscription Section 1.9, “Updating Contract Tools” on page 11
Chapter 15, “Deactivation, Subscription Management, and Uninstalling” on
page 57

2.5.3 Copying and Pasting the Contents of Views

You can copy the contents of many Contract Tools pane views to the Windows clipboard, and
then paste this content elsewhere. This is useful for sharing content with others and for
creating new content. Here are examples:
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Copy and paste the
contents of this view

To create this To learn more, go to

Provisions Table of contents Chapter 4, “Working with Provisions” on page 26

Defined Terms Index of defined terms Chapter 5, “Working with Defined Terms” on
page 28

Drafting Errors List of potential problems Chapter 8, “Proofreading Documents” on page 36

To-Dos Issues list, to-do list Chapter 9, “Finding To-Dos” on page 43

Ancillaries List of ancillaries Chapter 10, “Working with Ancillaries” on page 45

Search Lists of words and phrases,
amounts of money, dates,
and so on

Chapter 12, “Finding Text” on page 48

To copy all of a view’s contents, choose the Copy command from the Action pop-up menu in
the view. To copy part of a view’s contents, use the Filter field at the bottom of the view before
copying. To include page numbers when you copy, choose “Copy with Page Numbers” from the
Action pop-up menu.

Note: Copying with page numbers may take several seconds.

To paste in many Windows applications, press Control-V. What you paste depends on the
application you’re using:

• In rich text editors (like an email in Outlook or a document in Word), you paste rich text.

• In spreadsheet applications (like Excel) and plain text editors (like Notepad), you paste
tab-separated values.

When you paste the contents of the Defined Terms view and the Ancillaries view as rich text,
use counts are not included. When you paste the contents of these views as tab-separated
values, use counts are included.

To learn about Contract Tools pane views, see Section 2.5.2, “Contract Tools Pane Views” on the
previous page.

2.5.4 The Issues Pop-Up Menu
You can use the Issues pop-up menu at the bottom of the Contract Tools pane to see a list of
potential problems.

The Issues pop-up menu shows this To learn more, go to

Unused defined terms, defined terms used once Chapter 5, “Working with Defined Terms” on page 28

Cross-references to unknown items
Chapter 6, “Working with Cross-References” on page 32

Drafting errors Chapter 8, “Proofreading Documents” on page 36

To-dos Chapter 9, “Finding To-Dos” on page 43

Choose an item in the Issues pop-up menu to learn more about it. To choose which items
appear in the Issues pop-up menu, click the Preferences button at the top of the Contract Tools
pane, and then use the Issues Pop-Up Menu controls.
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2.5.5 The Analyze Button

Click the Analyze button at the bottom of the Contract Tools pane to update Contract Tools’
analysis, and click the arrow next to the Analyze button to choose whether Contract Tools
analyzes all or part of your document; see Section 3.2, “Updating Analysis” on page 22 and
Section 3.3, “Analyzing Part of a Document” on page 23 to learn more. To learn general
information about analysis, see Chapter 3, “Analyzing Documents” on the next page.
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Chapter 3

Analyzing Documents

Learn about the kinds of information Contract Tools finds. Update
Contract Tools’ analysis. Analyze all or part of a document. Import
and export analysis settings. Learn about analyzing when using
Track Changes. Include tables in Contract Tools’ analysis.

To learn about Go to

What Contract Tools finds when it analyzes your
document

Section 3.1, “Analyzing Generally” on this page

Ways to reanalyze as you make changes Section 3.2, “Updating Analysis” on the next page

Limiting Contract Tools’ analysis Section 3.3, “Analyzing Part of a Document” on
page 23

Saving customized analysis settings, ignored
defined terms, and more

Section 3.4, “Saving Analysis Settings” on page 23

Excluding deletions from Contract Tools’ analysis
when using Track Changes

Section 3.5, “Analyzing When Using Track Changes”
on page 24

Including tables in Contract Tools’ analysis Section 3.6, “Analyzing Tables” on page 25

3.1 Analyzing Generally
Contract Tools finds a variety of items when it analyzes your document.

Contract Tools finds this To learn more, go to

Provisions, provision numbers, provision titles Chapter 4, “Working with Provisions” on page 26

Defined terms Chapter 5, “Working with Defined Terms” on page 28

Cross-references Chapter 6, “Working with Cross-References” on
page 32
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Contract Tools finds this To learn more, go to

Drafting errors Chapter 8, “Proofreading Documents” on page 36

To-dos Chapter 9, “Finding To-Dos” on page 43

Ancillaries Chapter 10, “Working with Ancillaries” on page 45

Inline lists, proviso lists Chapter 11, “Working with Inline Lists and Proviso
Lists” on page 47

Amounts of money, durations, dates, times of day Section 12.2, “Finding Numbers, Amounts of Money,
and Dates and Times” on page 49

You can use many tools and techniques to work with these items; see Chapter 2, “Tools and
Techniques” on page 13 to learn more.

Contract Tools’ analysis updates automatically as you type and delete text, and you can also
update Contract Tools’ analysis manually after you make other kinds of changes; see
Section 3.2, “Updating Analysis” on this page to learn more.

You can limit Contract Tools’ analysis to part of a document, which is useful for excluding items
like tables of contents and signatures from Contract Tools’ analysis; see Section 3.3, “Analyzing
Part of a Document” on the next page to learn more.

To customize how Contract Tools analyzes your document, you can adjust analysis settings. To
learn about analysis settings for defined terms, see Section 5.1, “Finding Defined Terms” on
page 28; to learn about analysis settings for drafting errors, see Section 8.1, “Checking for
Drafting Errors” on page 36. Analysis settings are saved with your document; see Section 3.4,
“Saving Analysis Settings” on the next page to learn more.

You can adjust Track Changes settings to make Contract Tools’ analysis include or exclude
tracked deletions; see Section 3.5, “Analyzing When Using Track Changes” on page 24 to learn
more.

By default, Contract Tools does not analyze content within tables. To learn how to make
Contract Tools analyze content within tables, see Section 3.6, “Analyzing Tables” on page 25.

To troubleshoot problems with analysis, see Section 16.11, “Analyzing a Document Converted
from a PDF Takes a Long Time” on page 67 and Section 16.12, “Contract Tools Won’t Find
Content” on page 68.

3.2 Updating Analysis
Generally, Contract Tools updates its analysis automatically as you type and delete text. To turn
off automatic updating, show the Contract Tools pane, click the Preferences button, click More
below Analysis, and then deselect the “Update analysis after typing and deleting text” checkbox.

After you make some kinds changes to your document (for example, editing a defined term or
pasting text), it’s a good idea to make Contract Tools reanalyze your document.

Here are ways to make Contract Tools reanalyze your document:

• Click the Analyze button at the bottom of the Contract Tools pane (see Section 2.5, “The
Contract Tools Pane” on page 16 to learn more). When there are unanalyzed changes, the
Analyze button becomes blue.
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• Save your document. To quickly save your document, press Control-S. To stop Contract Tools
from analyzing your document when you save, show the Contract Tools pane, click the
Preferences button, and then deselect the “Analyze when saving” checkbox.

• Click the Analyze button in the Contract Tools ribbon tab (see Section 2.1, “The Contract Tools
Ribbon Tab” on page 13 to learn more).

3.3 Analyzing Part of a Document
You can make Contract Tools analyze part of your document. This is useful if you want to
exclude content from Contract Tools’ analysis, for example:

• A cover page, a table of contents, and other content that appears at the beginning of a
document

• Signature blocks, exhibits, schedules, and other content that appears at the end of a
document

This is also useful if you want to analyze a contract that’s part of a larger document.

To make Contract Tools analyze part of your document:

1. Select the part of your document that you want Contract Tools to analyze. To select text, drag
the mouse pointer over text. Or, set the insertion point (cursor) at the beginning of the text you
want to select, and then Shift-click the end of the text you want to select.

2. Click the arrow next to the Analyze button at the bottom of the Contract Tools pane; see
Section 2.5, “The Contract Tools Pane” on page 16 to learn more.

3. Choose Analyze Selection.

To see the part of your document that Contract Tools analyzes, click the arrow next to the
Analyze button at the bottom of the Contract Tools pane, and then choose Show Analyzed
Selection. To make Contract Tools analyze your entire document, choose Analyze Document.

Note: The part of your document that Contract Tools analyzes is included in your document as
a hidden bookmark named _PaperSoftwareContractToolsAnalysisRange. When you choose
Analyze Document, you delete this hidden bookmark. To learn about bookmarks, search for
“bookmarks” in Word Help.

By default, when a document opens, Contract Tools automatically selects the part of the
document that’s best suited to analysis, if possible. To turn this off, show the Contract Tools
pane, click the Preferences button, click More below Analysis, and then deselect the “Set
analysis range when documents open” checkbox.

Also, by default, Contract Tools does not analyze content within tables, even if you make
Contract Tools analyze a part of your document that includes tables. To learn how to make
Contract Tools analyze content within tables, see Section 3.6, “Analyzing Tables” on page 25.

3.4 Saving Analysis Settings
In Word 2010 and later, Contract Tools saves the following items with your documents as
custom XML data by default:
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• Analysis settings (see Section 5.1, “Finding Defined Terms” on page 28 to learn about
analysis settings for defined terms, and see Section 8.1, “Checking for Drafting Errors” on
page 36 to learn about analysis settings for drafting errors)

• Ignored defined terms, drafting errors, and ancillaries (see Section 5.3, “Managing Defined
Terms” on page 30, Section 8.3, “Managing Drafting Errors” on page 41, and Chapter 10,
“Working with Ancillaries” on page 45 to learn more)

To disable saving these items with your documents, show the Contract Tools pane, click the
Preferences button, click More below Analysis, and then deselect the “Save analysis settings as
custom XML data” checkbox.

If you disable saving these items with your documents, or if you use software that removes
custom XML data from your documents, you can export these items and import them when
you use Contract Tools. To do this, show the Contract Tools pane, click the Analysis Settings
button, and then click Export or Import at the bottom of the Analysis Settings view.

To learn about custom XML data, search for “custom XML data” in Word Help.

3.5 Analyzing When Using Track Changes
As you work on your document, you may use Track Changes to make your edits easy to see. To
learn about Track Changes, search for “track changes” in Word Help.

Contract Tools analyzes text that appears in your document, including tracked deletions. To
exclude tracked deletions from Contract Tools’ analysis, configure Track Changes to hide
tracked deletions or show them next to your document. To configure Track Changes, use the
controls in the Tracking group within the Review ribbon tab.

Here are ways to exclude tracked deletions from Contract Tools’ analysis:

• Hide tracked deletions. To do this:

• In Word 2013 and later (including Word for Microsoft 365), choose Simple Markup or No
Markup from the “Display for Review” pop-up menu at the top of the Tracking group.

• In Word 2010 and 2007, choose Final from the “Display for Review” pop-up menu at the
top of the Tracking group.

• Show tracked deletions next to your document. To do this:

• In Word 2013 and later (including Word for Microsoft 365), choose All Markup from the
“Display for Review” pop-up menu at the top of the Tracking group, and then choose
Show Markup > Balloons > Show Revisions in Balloons.

• In Word 2010, choose Final: Show Markup from the “Display for Review” pop-up menu at
the top of the Tracking group, and then choose Show Markup > Balloons > Show Revisions
in Balloons.

• In Word 2007, choose Final Showing Markup from the “Display for Review” pop-up menu
at the top of the Tracking group, and then choose Balloons > Show Revisions in Balloons.

After configuring Track Changes, you should update Contract Tools’ analysis; see Section 3.2,
“Updating Analysis” on page 22 to learn how.
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3.6 Analyzing Tables
By default, Contract Tools does not analyze content within tables (search for “tables” in Word
Help to learn more). If your document includes content that you want Contract Tools to
analyze within tables, or if your document is laid out using tables, you can make Contract Tools
analyze content within tables.

To make Contract Tools analyze content within tables:

• Show the Contract Tools pane, click the Analysis Settings button, and then deselect the “Don’t
analyze tables” checkbox.
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Chapter 4

Working with Provisions

Learn how Contract Tools finds provisions. Navigate provisions.
Create cross-references using copy and paste. Filter provisions by
number or title.

To learn about Go to

How Contract Tools finds provisions Section 4.1, “Finding Provisions” on this page

Navigating and filtering provisions Section 4.2, “Managing Provisions” on this page

4.1 Finding Provisions
When analyzing a document, Contract Tools finds provisions, provision numbers, and provision
titles.

To learn more about how Contract Tools analyzes documents, see Chapter 3, “Analyzing
Documents” on page 21. To learn about troubleshooting problems with finding provisions in
documents laid out using tables, see Section 16.12, “Contract Tools Won’t Find Content” on
page 68.

4.2 Managing Provisions
You can use the Provisions view to manage provisions. To show the Provisions view, click the
Provisions button at the top of the Contract Tools pane.
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The Provisions button.

Go to a provision.

Choose an action for
provisions.

Filter provisions.

Here are ways to use the Provisions view:

• To go to a provision, click a provision in the view. To learn about other ways to navigate
provisions, see Section 2.2, “Navigating Documents” on page 14.

• To copy a list of provisions to the clipboard, choose Copy Provisions from the Action pop-up
menu at the bottom of the view; see Section 2.5.3, “Copying and Pasting the Contents of
Views” on page 18 to learn more.

• To copy a cross-reference to a selected provision to the clipboard, click a provision in the view
to select it, and then choose “Copy Cross-Reference” from the Action pop-up menu at the
bottom of the view. To paste this cross-reference into your document, press Control-V. To learn
more about cross-references, see Chapter 6, “Working with Cross-References” on page 32.

• To find a provision in the view, type the number or title of the provision you want to find in the
Filter field at the bottom of the view.
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Chapter 5

Working with Defined Terms

Manage the words and phrases that Contract Tools interprets as
defined terms. Include defined terms from another document.
Ignore and restore defined terms.

To learn about Go to

How Contract Tools finds defined terms Section 5.1, “Finding Defined Terms” on this page

Including defined terms found in another document Section 5.2, “Including Defined Terms from Another
Document” on page 30

Navigating, ignoring, and restoring defined terms Section 5.3, “Managing Defined Terms” on page 30

Inserting uses of defined terms into your document Section 5.4, “Using Defined Terms” on page 31

5.1 Finding Defined Terms
By default, Contract Tools finds defined terms using double quotation marks (“ ”, " ") or
guillemets (« », ‹ ›). Alternatively, you can make Contract Tools find defined terms using text
formatting (available in Word 2010 and later) or single quotation marks (‘ ’, ' '). To choose how
Contract Tools finds defined terms, show the Contract Tools pane, click the Analysis Settings
button, and then use the Defined Terms controls.

Note: It’s a good idea to make Contract Tools find defined terms using text formatting only if
defined terms aren’t enclosed in double quotation marks or guillemets. It’s a good idea to make
Contract Tools find defined terms using single quotation marks only if defined terms aren’t
formatted.

When Contract Tools finds defined terms, it ignores some words and phrases that would
otherwise be interpreted as defined terms if they’re not used:

• Words and phrases that are preceded by definition of, heading, trademark, and so on

• Words and phrases that are followed by as set forth, format, shall exclude, and so on
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In addition, Contract Tools ignores numbers and amounts of money when it finds defined
terms; see Appendix A, “Finding Amounts of Money” on page 75 to learn about the currencies
Contract Tools detects.

You may want Contract Tools to ignore some kinds of words and phrases when it finds defined
terms.

To make Contract Tools ignore words and phrases when it finds defined terms:

• Show the Contract Tools pane, click the Analysis Settings button, click Exclude below Defined
Terms, and then select the kinds of words and phrases you want Contract Tools to ignore.

Select this To make Contract Tools ignore these kinds of
words and phrases

Cross-reference prefixes, ancillaries, and proviso
markers

Article
clause
Exhibit
provided that
provided, however
Schedule
Section

Words and phrases that appear in US laws closely held
employee benefit plan
hazardous substance
well-known seasoned issuer

Lowercase words and phrases defined in the
Uniform Commercial Code

account debtor
electronic chattel paper
net proceeds
uncertificated security

Common jargon and
blue sky
earn-out
flex

In general, the words and phrases that you can make Contract Tools ignore when it finds
defined terms are lowercase.

Note: Contract Tools always interprets ignorable words and phrases as defined terms when
they appear in a list of defined terms and definitions.

To troubleshoot problems with finding defined terms in documents laid out using tables, see
Section 16.12, “Contract Tools Won’t Find Content” on page 68.

To learn how to include defined terms Contract Tools finds in another document in your main
document, see Section 5.2, “Including Defined Terms from Another Document” on the next
page. To learn how to manage defined terms, including how to ignore defined terms, see
Section 5.3, “Managing Defined Terms” on the next page. To learn how to complete uses of
defined terms as you type, see Section 5.4, “Using Defined Terms” on page 31.
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5.2 Including Defined Terms from Another Document
You can make Contract Tools include defined terms from another document in your main
document. This is useful when you’re working with related documents, like a document that
uses defined terms in a separate definitions list.

The document with the defined terms that you want to include in your main document must
be open in Word, and it must not be a new, unsaved document. Also, both documents must be
open in the same instance of Word.

To include defined terms from another document:

• Show the Contract Tools pane, click the Analysis Settings button, click the “Include from”
pop-up menu, and then choose the document with the defined terms you want to include.

To troubleshoot problems with including defined terms from another document, see
Section 16.13, “Including Defined Terms from Another Document Is Impossible” on page 68.

To learn how Contract Tools finds defined terms, see Section 5.1, “Finding Defined Terms” on
page 28.

5.3 Managing Defined Terms
You can use the Defined Terms view to manage defined terms. To show the Defined Terms
view, click the Defined Terms button at the top of the Contract Tools pane.

The Defined Terms button.

Sort defined terms
alphabetically or by
number of uses.

Ignore a defined term.

Choose an action for
defined terms.

Filter defined terms.

Here are ways to use the Defined Terms view:

• To sort defined terms alphabetically or by number of uses, click one of the buttons at the top
left of the view.

• To go to where a defined term is defined, click a defined term in the view. To learn about other
ways to go to where a defined term is defined, see Section 2.2, “Navigating Documents” on
page 14.

• To show where a defined term is used, click the disclosure triangle next to a defined term. You
can also use the Previous and Next buttons to find uses of defined terms; see Section 2.5.1, “The
Context Button; the Previous and Next Buttons” on page 17 to learn more.
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• To ignore a defined term, click a defined term in the view to select it, and then click the Ignore
button (×) at the bottom of the view or press the Backspace key. Defined terms you ignore are
saved with your document by default; see Section 3.4, “Saving Analysis Settings” on page 23 to
learn more.

• To restore a defined term you’ve ignored, choose Show Ignored Defined Terms from the Action
pop-up menu at the bottom of the view, select the ignored defined term you want to restore,
and then click the Restore button at the bottom of the view or press the Backspace key.

• To quickly restore all ignored defined terms, choose Restore Ignored Defined Terms from the
Action pop-up menu at the bottom of the view.

• To copy a list of defined terms to the clipboard, choose Copy Defined Terms from the Action
pop-up menu at the bottom of the view; see Section 2.5.3, “Copying and Pasting the Contents
of Views” on page 18 to learn more.

• To find a defined term in the view, type all or part of the defined term you want to find in the
Filter field at the bottom of the view.

Defined terms are highlighted when you select them; see Section 2.3, “Highlighting Content” on
page 15 to learn more.

To learn how Contract Tools finds defined terms, see Section 5.1, “Finding Defined Terms” on
page 28.

5.4 Using Defined Terms
You can insert uses of defined terms into your document by typing, and you can use the
Completion menu to complete uses of defined terms as you type; see Section 2.4, “The
Completion Menu” on page 16 to learn more.

To learn how Contract Tools finds defined terms, see Section 5.1, “Finding Defined Terms” on
page 28.
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Chapter 6

Working with Cross-References

Navigate cross-references. Make cross-references update as you
edit your document.

To learn about Go to

How Contract Tools finds cross-references Section 6.1, “Finding Cross-References” on this page

Navigating cross-references Section 6.2, “Managing Cross-References” on this
page

Making cross-references update as you make
changes

Section 6.3, “Converting Text in Cross-References to
Fields” on the next page

6.1 Finding Cross-References
When analyzing a document, Contract Tools finds text that looks like cross-references, and
then finds the items to which these cross-references refer based on the text of the
cross-references, provision numbers (see Chapter 4, “Working with Provisions” on page 26 to
learn more), and inline list markers like (a) (b) (c) and (i) (ii) (iii) (see Chapter 11, “Working with
Inline Lists and Proviso Lists” on page 47 to learn more). Contract Tools ignores
cross-references to other documents, like statutes and ancillaries (see Chapter 10, “Working
with Ancillaries” on page 45 to learn more).

To learn about ways to work with cross-references, see Section 6.2, “Managing
Cross-References” on this page. To learn how to convert text in cross-references to fields, see
Section 6.3, “Converting Text in Cross-References to Fields” on the next page. To learn more
about how Contract Tools analyzes documents, see Chapter 3, “Analyzing Documents” on
page 21.

6.2 Managing Cross-References
You can use the Cross-References view to manage cross-references. To show the
Cross-References view, click the Cross-References button at the top of the Contract Tools pane.
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The Cross-References button.

Sort cross-references. Make cross-references update as you
edit your document.

Filter cross-references.

Here are ways to use the Cross-References view:

• To sort cross-references by referenced item, count, or location, click one of the buttons at the
top left of the view.

• To show all cross-references or a kind of cross-reference, use the Show pop-up menu at the
top left of the view.

• To convert text in cross-references to fields, click “Convert to Fields” at the top right of the view;
see Section 6.3, “Converting Text in Cross-References to Fields” on this page to learn more.

• To go to a cross-reference, click a cross-reference in the view. You can also use the Previous
and Next buttons to go to cross-references; see Section 2.5.1, “The Context Button; the
Previous and Next Buttons” on page 17 to learn more.

• To find cross-references to unknown items, sort the Cross-References view by item or count,
and then click the disclosure triangle next to Unknown. You can also use the Issues pop-up
menu; see Section 2.5.4, “The Issues Pop-Up Menu” on page 19 to learn more.

• To go to the item to which a cross-reference refers, sort the Cross-References view by location,
and then click the arrow to the right of the cross-reference. To learn about other ways to go to
the item to which a cross-reference refers, see Section 2.2, “Navigating Documents” on page 14.

When you select a cross-reference, cross-references to the same item are highlighted; see
Section 2.3, “Highlighting Content” on page 15 to learn more.

You can copy a cross-reference to a provision you select in the Provisions View to the clipboard;
see Section 4.2, “Managing Provisions” on page 26 to learn more.

To learn how Contract Tools finds cross-references, see Section 6.1, “Finding Cross-References”
on the previous page.

6.3 Converting Text in Cross-References to Fields
You can convert text in cross-references to fields that update as you make changes. To learn
about fields and how to update them, search for “field” and “update fields” in Word Help.

Here are ways to convert text in cross-references to fields:

• To convert text in a selected cross-reference to a field, click the Context button; see
Section 2.5.1, “The Context Button; the Previous and Next Buttons” on page 17 to learn more.
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• To convert text in all cross-references to fields, click “Convert to Fields” at the top of the
Cross-References view; see Section 6.2, “Managing Cross-References” on page 32 to learn
more.

Text in some cross-references may not be convertible to fields. To find text that isn’t convertible
to fields, choose Not Convertible from the Show pop-up menu at the top of the
Cross-References view.

For text in a cross-reference to be convertible to a field:

• The cross-reference must include only text, not a field. To find cross-references that include
only text, choose Text from the Show pop-up menu at the top of the Cross-References view.

• The cross-reference must include full context (alphanumerics for the cross-referenced item and
all parent items) or no context (an alphanumeric for only the cross-referenced item): for
example, Section 3.1(d)(i) or clause (i), not clause (d)(i).

• The item to which the cross-reference refers must be known; see Section 6.2, “Managing
Cross-References” on page 32 to learn how to find cross-references to unknown items.

• The item to which the cross-reference refers must use multilevel list numbering; search for
“multilevel list” in Word Help to learn more.

If text that you want to convert to fields isn’t convertible, try editing your document to make
text convertible. For example, make sure the items to which cross-references refer use
multilevel list numbering, or edit cross-references to include full context. As an alternative, use
Word’s built-in controls to create cross-references; search for “cross-reference” in Word Help to
learn how.

If you convert a cross-reference to a field, and then delete the item to which the
cross-reference refers, the field is flagged as a drafting error; see Chapter 8, “Proofreading
Documents” on page 36 to learn more.

To learn about other ways to work with cross-references, see Section 6.2, “Managing
Cross-References” on page 32. To learn how Contract Tools finds cross-references, see
Section 6.1, “Finding Cross-References” on page 32.
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Chapter 7

Finding Related Items

Find provisions and other items that are related to an item you
choose.

You can use the Related Items view to find items that are related to an item you choose. For
example, you can use the Related Items view to find provisions that contain cross-references to
the provision you’re working with. To show the Related Items view, click the Related Items
button at the top of the Contract Tools pane.

The Related Items button.

Sort related items. Click the Scope button to go back to
the item to which the Related Items
view applies.

Here are ways to use the Related Items view:

• To choose the item to which the Related Items view applies, select an item in your document.
You can select an item by clicking or by setting the insertion point (cursor) using the arrow keys.

• To sort related items alphabetically or in the order in which they appear in your document, click
Item at the top left of the view. To sort related items by number of items, click Count at the top
left of the view.

• To see more information about a related item, click the disclosure triangle next to the item.

• To go to a related item, click an item in the view.

• To go back to the item to which the Related Items view applies, click the Scope button at the
top right of the view.
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Chapter 8

Proofreading Documents

Check your document for common contract drafting errors.
Ignore and restore drafting errors.

Contract Tools checks your document for common kinds of contract drafting errors.

To learn about Go to

Kinds of drafting errors Contract Tools finds;
excluding words and phrases while proofreading

Section 8.1, “Checking for Drafting Errors” on this
page

Ways to review drafting errors Section 8.2, “Reviewing Drafting Errors” on page 40

Navigating, ignoring, and restoring drafting errors Section 8.3, “Managing Drafting Errors” on page 41

8.1 Checking for Drafting Errors
Contract Tools checks for the following kinds of drafting errors:

Not defined: Capitalized words and phrases that are not uses of a defined term.

Duplicate defined terms: Defined terms that are defined more than once.

Miscapitalized defined terms: Uses of defined terms with inconsistent letter case.

Formatting inconsistencies: Inconsistently formatted provision titles, defined terms,
cross-references, and ancillaries (available in Word 2010 and later).

List order: Problems with the order of provision numbers, inline list markers (such as (a) (b) (c)
and (i) (ii) (iii)), and defined terms in definitions lists.

Unmatched punctuation: Unmatched parentheses, brackets ([ ]), braces ({ }), curly double
quotation marks (“ ”), and guillemets (« », ‹ ›).

Broken Ref fields: Ref fields whose Bookmark property is unknown. For example, if you convert
a cross-reference to a field, and then delete the item to which the cross-reference refers, the
field is flagged as a drafting error. To learn about Ref fields, search for “ref field” in Word Help.
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To learn about Go to

Provisions Chapter 4, “Working with Provisions” on page 26

Defined terms Chapter 5, “Working with Defined Terms” on page 28

Cross-references Chapter 6, “Working with Cross-References” on page 32

Ancillaries Chapter 10, “Working with Ancillaries” on page 45

Inline lists Chapter 11, “Working with Inline Lists and Proviso Lists” on page 47

Contract Tools ignores some errors by default. To choose the kinds of errors that Contract Tools
ignores, show the Contract Tools pane, click the Analysis Settings button, and then use the
Drafting Errors controls.

Here are errors that Contract Tools ignores by default:

Adjacent uses of defined terms: When Contract Tools checks for capitalized words and phrases
that are not uses of a defined term, it ignores adjacent uses of defined terms.

Duplicate defined terms: When Contract Tools checks for duplicate defined terms, it ignores
different forms of the same defined term (for example, “Company”, “Companies”, and “the
Company”) that appear in the same paragraph.

Miscapitalized defined terms: When Contract Tools checks for miscapitalized defined terms, it
ignores all-uppercase and all-lowercase text. For example, ifMaterial Contract is a defined term,
Contract Tools finds material Contract, but not material contract.

Capitalized words and phrases: Contract Tools ignores many kinds of capitalized words and
phrases when it checks for those that are not uses of a defined term. To select the kinds of
capitalized words and phrases that Contract Tools ignores, click Exclude below Drafting Errors
in the Analysis Settings view, and then select the kinds of capitalized words and phrases you
want Contract Tools to ignore.

Select this To make the Proofreader ignore these kinds of capitalized
words and phrases

Accounting and finance terms Goldman, Sachs & Co.
PricewaterhouseCoopers
Baa3
New York Stock Exchange
The Wall Street Journal

Arbitration forums American Arbitration Association
Judicial Arbitration and Mediation Services
JAMS

Business entities Paper Software LLC
Paper Software, Inc.
OOO Paper Software
Paper Software, SA/NV
Paper Software s.à r.l.
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Select this To make the Proofreader ignore these kinds of capitalized
words and phrases

Business entity terms Board of Directors
Audit Committee
Chief Executive Officer
Assistant Secretaries
Articles of Formation
Class A
Series B

Canadian government bodies Bank of Canada
Canada Mortgage and Housing Corporation
Department of Foreign Affairs and International Trade

Canadian statutes Bankruptcy and Insolvency Act
Food and Drugs Act
Winding-up and Restructuring Act

Contact information Attention
Facsimile
Email

Dates and times Midnight
Friday
December
Eastern Standard Time

Government bodies Consumer Financial Protection Bureau
Department of Justice
Ministry of Defence

Incentive plans Approved Share Option Scheme
Long Term Incentive Plan
Restricted Stock Plan

Intergovernmental organizations European Union
United Nations
World Trade Organization

Jargon Amended and Restated Plan of Merger
Article
Federal
Form of Notice
Stock Purchase Agreement
Risk Factors

Law firms Adams and Reese
Krieg DeVault
Wyatt, Tarrant & Combs

Medical and scientific terms COVID
Good Clinical Practices
New Drug Application
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Select this To make the Proofreader ignore these kinds of capitalized
words and phrases

Names and honorifics James Smith, Esq.
Dr. Mary Johnson

Places Central America
United States of America
British Columbia
New York City
Bailiwick of Guernsey

Regulations and forms International Traffic in Arms Regulations
FormW-8BEN
Regulation S-X
Rule 144A
Schedule 14D-9

Self-regulatory organizations Accounting Principles Board
Financial Industry Regulatory Authority
Public Company Accounting Oversight Board

Statute titles Bankruptcy Code
Companies Act
Treaty of Amsterdam

Technology terms PDF
Internet
MIT License

UK government bodies Bank of England
Financial Services Trade and Investment Board
Her Majesty’s Treasury

UK public general acts Contracts (Rights of Third Parties) Act
Financial Services (Banking Reform) Act
Income and Corporation Taxes Act

Uniform laws National Conference of Commissioners on Uniform State Laws
UCC
Uniform Gifts to Minors Act

US federal courts Supreme Court of the United States
United States Court of Appeals for the Second Circuit
United States Court of Federal Claims
Southern District of New York

US federal government bodies Federal Reserve System
Patent and Trademark Office
Electronic Data Gathering, Analysis, and Retrieval System
Flood Insurance Rate Map

US federal statutes COBRA
Food, Drug, and Cosmetic Act
Worker Adjustment and Retraining Notification Act
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Select this To make the Proofreader ignore these kinds of capitalized
words and phrases

US state business entity regulators Delaware Secretary of State
Secretary of State of New York
Virginia State Corporation Commission

US state business entity statutes General Corporation Law of the State of Delaware
New York Partnership Law
Beverly-Killea Limited Liability Company Act

US state courts Delaware Court of Chancery
New York Supreme Court
California Court of Appeal for the First District

Contract Tools always ignores the following kinds of capitalized words and phrases when it
checks for those that are not uses of a defined term:

All caps: Contract Tools ignores paragraphs set in all uppercase letters (all caps).

Alphanumeric codes: Contract Tools ignores alphanumeric codes (such as B26354).

Capitalized words at the beginning of sentences: Contract Tools ignores capitalized words
that appear only at the beginning of sentences. In addition, Contract Tools ignores words
commonly used to begin sentences (such as The, Each, and Notwithstanding) when they appear
at the beginning of sentences, even if they also appear elsewhere.

Currencies: Contract Tools ignores currencies (such as US Dollars, USD, Euros, and EUR). To learn
about the currencies Contract Tools detects, see Appendix A, “Finding Amounts of Money” on
page 75.

Numbers: Contract Tools ignores numbers (such as One, One Hundred Million, and First).

Provision titles: Contract Tools ignores provision titles when they appear at the start of a
provision and when they appear within parentheses or brackets ([ ]).

Quotation marks: Contract Tools ignores capitalized words and phrases enclosed in double
quotation marks (“ ”, " ") or guillemets (« », ‹ ›).

Singular and plural forms of defined terms: You may use singular defined terms in their plural
forms, and plural defined terms in their singular forms (for example, you may define Subsidiary
but use Subsidiaries). Contract Tools ignores singular and plural forms of defined terms. To learn
about defined terms, see Chapter 5, “Working with Defined Terms” on page 28.

Note: Contract Tools does not check for drafting errors in comments, footnotes, and endnotes
(search for “comments”, “footnotes”, and “endnotes” in Word Help to learn more).

To learn about ways to review drafting errors, see Section 8.2, “Reviewing Drafting Errors” on
this page. To learn how to manage drafting errors, including how to ignore drafting errors, see
Section 8.3, “Managing Drafting Errors” on the next page.

8.2 Reviewing Drafting Errors
You can use a variety of tools and techniques to review drafting errors:
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Highlighting: Drafting errors are highlighted in red in your document by default; see
Section 2.3, “Highlighting Content” on page 15 to learn more.

Previous and Next buttons: When you select a drafting error in your document, you can use
the Previous and Next buttons to find similar drafting errors; see Section 2.5.1, “The Context
Button; the Previous and Next Buttons” on page 17 to learn more.

Issues pop-up menu: A brief list of drafting errors appears in the Issues pop-up menu; see
Section 2.5.4, “The Issues Pop-Up Menu” on page 19 to learn more.

Drafting Errors view: Detailed information about drafting errors appears the Drafting Errors
view; see Section 8.3, “Managing Drafting Errors” on this page to learn more.

To learn about the drafting errors Contract Tools finds, see Section 8.1, “Checking for Drafting
Errors” on page 36. To learn how to manage drafting errors, including how to ignore drafting
errors, see Section 8.3, “Managing Drafting Errors” on this page.

8.3 Managing Drafting Errors
You can use the Drafting Errors view to manage drafting errors. To show the Drafting Errors
view, click the Drafting Errors button at the top of the Contract Tools pane.

The Drafting Errors button.

Sort drafting errors.

Ignore a drafting error.

Choose an action for
drafting errors.

Filter drafting errors.

Here are ways to use the Drafting Errors view:

• To sort drafting errors by category, count, or location, click one of the buttons at the top left of
the view.

• To go a drafting error, click a drafting error in the view. You can also use the Previous and Next
buttons to go to drafting errors; see Section 2.5.1, “The Context Button; the Previous and Next
Buttons” on page 17 to learn more.

• To ignore a drafting error, click a drafting error in the view to select it, and then click the Ignore
button (×) at the bottom of the view or press the Backspace key. You can also use the Context
button to ignore drafting errors; see Section 2.5.1, “The Context Button; the Previous and Next
Buttons” on page 17 to learn how. Drafting errors you ignore are saved with your document by
default; see Section 3.4, “Saving Analysis Settings” on page 23 to learn more.

Note: You ignore categories of drafting errors, not individual drafting errors. You cannot ignore
list order errors, unmatched punctuation errors, and broken Ref field errors.
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• To restore a drafting error you’ve ignored, choose Show Ignored Drafting Errors from the Action
pop-up menu at the bottom of the view, select the ignored drafting error you want to restore,
and then click the Restore button at the bottom of the view or press the Backspace key.

• To quickly restore all ignored drafting errors, choose Restore Ignored Drafting Errors from the
Action pop-up menu at the bottom of the view.

• To copy a list of drafting errors to the clipboard, choose Copy Drafting Errors from the Action
pop-up menu at the bottom of the view; see Section 2.5.3, “Copying and Pasting the Contents
of Views” on page 18 to learn more.

• To quickly fix all formatting inconsistencies, choose Fix Formatting Inconsistencies from the
Action pop-up menu at the bottom of the view.

Note: Before fixing all formatting inconsistencies, it’s a good idea to review formatting
inconsistencies and ignore the ones you don’t want to change.

• To find a drafting error in the view, type all or part of the drafting error you want to find in the
Filter field at the bottom of the view.

To learn about the drafting errors Contract Tools finds, see Section 8.1, “Checking for Drafting
Errors” on page 36. To learn about other ways to review drafting errors, see Section 8.2,
“Reviewing Drafting Errors” on page 40.
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Chapter 9

Finding To-Dos

Find placeholders, bracketed text, highlighted text, comments,
and more.

The To-Dos view shows items that may be unfinished:

• Placeholders such as [_], {_}, [•], {*}; also two or more underscores (_) or three or more
spaces

• Text enclosed in brackets ([ ]) or braces ({ })

Note: Contract Tools does not flag text like [intentionally omitted], [Reserved.], and so on as
to-dos.

• Highlighted text (search for “highlight” in Word Help to learn more)

• Comments, footnotes, and endnotes (search for “comments”, “footnotes”, and “endnotes”
in Word Help to learn more)

To show the To-Dos view, click the To-Dos button at the top of the Contract Tools pane.

The To-Dos button.

Show all to-dos or
a kind of to-do.

Choose an action for
to-dos.

Filter to-dos.

Here are ways to use the To-Dos view:

• To show all to-dos or a kind of to-do, use the Show pop-up menu at the top left of the view.
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• To go to a to-do, click a to-do in the view.

• To copy a list of to-dos to the clipboard, choose Copy To-Dos from the Action pop-up menu at
the bottom of the view; see Section 2.5.3, “Copying and Pasting the Contents of Views” on
page 18 to learn more.

• To find a to-do in the view, type all or part of the to-do you want to find in the Filter field at the
bottom of the view.

Placeholders are highlighted when you select them; see Section 2.3, “Highlighting Content” on
page 15 to learn more. You can also find placeholders using the Previous and Next buttons; see
Section 2.5.1, “The Context Button; the Previous and Next Buttons” on page 17 to learn how.
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Chapter 10

Working with Ancillaries

Find references to other documents.

Some documents refer to exhibits, schedules, and so on. In Contract Tools, these items are
called ancillaries. You can use the Ancillaries view to find ancillaries. To show the Ancillaries view,
click the Ancillaries button at the top of the Contract Tools pane.

The Ancillaries button.

Sort ancillaries
alphabetically or by
number of uses.

Go to an ancillary.

Ignore an ancillary.

Choose an action for
ancillaries.

Filter ancillaries.

Here are ways to use the Ancillaries view:

• To sort ancillaries alphabetically or by number of uses, click one of the buttons at the top left of
the view.

• To show the locations of ancillary references, click the disclosure triangle to the left of an
ancillary.

• To go to an ancillary, click its location. You can also use the Previous and Next buttons to go to
ancillaries; see Section 2.5.1, “The Context Button; the Previous and Next Buttons” on page 17
to learn more.

• To ignore an ancillary, click an ancillary in the view to select it, and then click the Ignore
button (×) at the bottom of the view or press the Backspace key. Ancillaries you ignore are
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saved with your document by default; see Section 3.4, “Saving Analysis Settings” on page 23 to
learn more.

• To restore an ancillary you’ve ignored, choose Show Ignored Ancillaries from the Action pop-up
menu at the bottom of the view, select the ignored ancillary you want to restore, and then click
the Restore button at the bottom of the view or press the Backspace key.

• To quickly restore all ignored ancillaries, choose Restore Ignored Ancillaries from the Action
pop-up menu at the bottom of the view.

• To copy a list of ancillaries to the clipboard, choose Copy Ancillaries from the Action pop-up
menu at the bottom of the view; see Section 2.5.3, “Copying and Pasting the Contents of
Views” on page 18 to learn more.

• To find an ancillary in the view, type all or part of the ancillary you want to find in the Filter field
at the bottom of the view.

Ancillaries are highlighted when you select them; see Section 2.3, “Highlighting Content” on
page 15 to learn more.
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Chapter 11

Working with Inline Lists and Proviso
Lists

Learn general information about inline lists and proviso lists.

When analyzing a document, Contract Tools finds inline lists (that include list markers like
(a) (b) (c) and (i) (ii) (iii)) and proviso lists (that include proviso markers like provided however and
provided, further). To learn more about how Contract Tools analyzes documents, see Chapter 3,
“Analyzing Documents” on page 21.

When you set the insertion point (cursor) in an inline list or a proviso list, list markers and
proviso markers are highlighted; see Section 2.3, “Highlighting Content” on page 15 to learn
more.
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Chapter 12

Finding Text

Find words and phrases in your document. Use tokens to find
numbers, amounts of money, dates, and more.

To learn about Go to

Finding words and phrases Section 12.1, “Finding Text Generally” on this page

Using tokens to find numbers, amounts of money,
and so on

Section 12.2, “Finding Numbers, Amounts of Money,
and Dates and Times” on the next page

12.1 Finding Text Generally
You can use the Search view to find all instances of words and phrases in your document. To
show the Search view, click the Search button at the top of the Contract Tools pane.

The Search button.

Search for words
and phrases.

To find text:

1. Enter the text you want to find in the search field.

2. Press Enter or click the search button (looks like a magnifying glass).

Search results appear below the search field, and the number of search results appears on the
right of the search field. To go to where a search result appears in your document, click a search
result below the search field. To copy a list of search results to the clipboard, choose Copy
Search Results from the Action pop-up menu at the top right of the view; see Section 2.5.3,
“Copying and Pasting the Contents of Views” on page 18 to learn more.

Search results are highlighted in your document; see Section 2.3, “Highlighting Content” on
page 15 to learn more.

To limit search results, select “Match case” or “Whole words”.
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Match case: When “Match case” is selected, you search for the uppercase and lowercase letters
you enter in the search field exactly as you enter them. When “Match case” is deselected, you
can use uppercase and lowercase letters interchangeably in the search field. For example, if you
search for partner when “Match case” is selected, you find partner but not Partner. If you search
for partner when “Match case” is deselected, you find both partner and Partner.

Whole words: When “Whole words” is selected, you find only what you enter in the search
field. When “Whole words” is deselected, you find text that contains what you enter in the
search field. For example, if you search for partner when “Whole words” is selected, you find
partner by itself, but not in words like partnership. If you search for partner when “Whole words” is
deselected, you find partner by itself and in words like partnership.

In addition to words and phrases, you can find amounts of money, durations, dates, and more;
see Section 12.2, “Finding Numbers, Amounts of Money, and Dates and Times” on this page to
learn how.

Note:When you use the search field:

• You search only the part of your document that Contract Tools analyzes (see Section 3.3,
“Analyzing Part of a Document” on page 23 to learn more).

• You don’t find text within comments, footnotes, and endnotes (search for “comments”,
“footnotes”, and “endnotes” in Word Help to learn more).

• You don’t find inline list markers like (a) (b) (c) and (i) (ii) (iii) and proviso markers like
provided however and provided, further (see Chapter 11, “Working with Inline Lists and
Proviso Lists” on page 47 to learn more).

• You don’t find provision numbers, cross-references, and ancillaries.

To learn about other ways to find Go to

Provisions Chapter 4, “Working with Provisions” on page 26

Cross-references Chapter 6, “Working with Cross-References” on page 32

Ancillaries Chapter 10, “Working with Ancillaries” on page 45

12.2 Finding Numbers, Amounts of Money, and Dates and
Times

You can use tokens in the search field to find numbers, amounts of money, dates, and more. To
insert tokens in the search field, choose a token from the Insert Token pop-up menu below the
search field.
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Add a token to the
search field.

Here are tokens you can use to find numbers, amounts of money, and dates and times:

Use this token To find this For example

number Digits, comma-separated numbers,
decimals, percentages, and numbers in
word form

1
1.0
one
50%
fifty percent
fifty per cent
fifty per centum
10,000,000
10 million
ten million
1st
first
58th
fifty-eighth

money Amounts of money denominated in the
currencies listed in Appendix A, “Finding
Amounts of Money” on page 75

$100
one hundred euros
100 zł
100 ringgits

duration Durations formatted in common ways one (1) business day
tenth Business Day
15 consecutive Trading Days
thirty (30) consecutive calendar days
181st day
four consecutive Fiscal Quarters

date Dates formatted in common ways August 30, 2010
30 Aug 2010
30th of August
1st day of January
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Use this token To find this For example

time of day Times of day formatted in common ways 9:30AM
9:30 a.m.
9:30am
9:30
12:00 noon
5:00p.m.
5:00 pm
5:00
5 PM
12:00 midnight

unit of time Commonly used measures of time seconds
minutes
hours
days
weeks
months
quarters
years
anniversary

word Any word —

You can use number , word , and the other tokens together with text to find a variety of
phrases. Here are examples:

When you search for this You can find phrases like this

number shares 1,000 shares
10 million shares
ten million shares

word stock A Stock
B Stock
Common Stock
Preferred Stock

number to number 4.25 to 1.00
3.0 to 1.0
one to one

number ( number ) ten (10)
fifty percent (50%)
one hundred (100,000)

money ( money ) ten million dollars ($10,000,000)
fifty pounds sterling (£50.00)
one million euros (¥10,000,000,000)

Amounts of money, durations, dates, and times of day are highlighted when you select them;
see Section 2.3, “Highlighting Content” on page 15 to learn more. You can also find these items
using the Previous and Next buttons; see Section 2.5.1, “The Context Button; the Previous and
Next Buttons” on page 17 to learn how.
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To learn about finding text generally, see Section 12.1, “Finding Text Generally” on page 48.
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Chapter 13

Working with Snippets

Create snippets from text you select in your document. Insert
snippets into your document. Use categories to organize snippets.

To learn about Go to

General information about snippets Section 13.1, “Understanding Snippets” on this page

Creating and deleting snippets Section 13.2, “Managing Snippets” on this page

Inserting snippets into your document Section 13.3, “Using Snippets” on the next page

Sorting snippets into categories Section 13.4, “Assigning Categories to Snippets” on
page 55

How snippets relate to other Word features Section 13.5, “Snippets and Building Blocks” on
page 55

13.1 Understanding Snippets
Snippets are useful for quickly inserting text you use often. You create snippets from text you
select in a document. Snippets you create in one document can be used in any of your other
documents. Snippets can be as long as you’d like, but it’s a good idea to limit them to a few
sentences.

Snippets are available in Word 2010 and later.

13.2 Managing Snippets
You can use the Snippets view to manage snippets. To show the Snippets view, click the
Snippets button at the top of the Contract Tools pane.
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The Snippets button.

Click a snippet’s
name to edit it.

Create a snippet
from text you select.

Insert a snippet. Choose an action for snippets.

Filter snippets.

Here are ways to use the Snippets view:

• To create a snippet, select text in your document, and then click the New button at the bottom
of the view. To select text, drag the mouse pointer over text. Or, set the insertion point (cursor)
at the beginning of the text you want to select, and then Shift-click the end of the text you
want to select.

You can create many snippets at once from paragraphs in your document. To do this, choose
one of the Convert commands from the Action pop-up menu at the bottom of the view.

If the New button and the Convert commands are always disabled, see Section 16.14, “Creating
Snippets Is Impossible” on page 69.

• To change the name of a snippet, click the snippet’s name to set the insertion point (cursor),
and then edit the name.

• To delete a snippet, click the snippet to select it, and then press the Backspace key or choose
Delete from the Action pop-up menu at the bottom of the view. If you want to delete many
snippets, use Shift-click to select the snippets you want to delete.

• To find a snippet in the view, type all or part of the snippet you want to find in the Filter field at
the bottom of the view.

If you use AutoText and Quick Parts, you may want to work with them the way you work with
snippets. To make AutoText and Quick Parts appear in the Snippets view, click the Preferences
button at the top of the Contract Tools pane, and then select “Include all AutoText and Quick
Parts” below Snippets. To learn about AutoText and Quick Parts, search for “AutoText” and
“Quick Parts” in Word Help.

You can sort snippets into categories; see Section 13.4, “Assigning Categories to Snippets” on
the next page to learn how.

13.3 Using Snippets
You can use a variety of techniques to add snippets to your document.

Here are ways to insert a snippet:

• Start typing the name of the snippet in your document, and then use the Completion menu to
choose the snippet you want to insert; see Section 2.4, “The Completion Menu” on page 16 to
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learn more.

• Click a snippet in the Snippets view to select it, and then click Insert at the bottom of the view
or press the Enter key.

• Double-click a snippet in the Snippets view.

After you insert a snippet, you may edit its text in your document, and you may want to see
how the text you edited differs from the snippet you originally inserted. To compare text you
select in your document to a selected snippet, choose “Compare Selection to Snippet” from the
Action pop-up menu at the bottom of the Snippets view.

13.4 Assigning Categories to Snippets
You can assign categories to snippets. To show categories in the Snippets view, click the
Preferences button at the top of the Contract Tools pane, and then select “Show categories”
below Snippets.

New snippets are categorized as General. To change the category of a snippet, use the controls
in the Building Blocks Organizer. To learn about the Building Blocks Organizer, search for
“building blocks organizer” in Word Help. To show the Building Blocks Organizer, choose
Building Blocks Organizer from the Action pop-up menu at the bottom of the Snippets view, or
choose Insert > Quick Parts > Building Blocks Organizer.

After you change the category of a snippet, you may need to refresh the Snippets view to see
your changes. To do this, choose “Refresh from Building Blocks” from the Action pop-up menu
at the bottom of the Snippets view.

To learn how snippets in Contract Tools relate to building blocks in Word, see Section 13.5,
“Snippets and Building Blocks” on this page. To learn about building blocks, search for “building
block” in Word Help.

13.5 Snippets and Building Blocks
When you create a snippet, you add an AutoText entry to Word. An AutoText entry is a kind of
building block; search for “AutoText” and “building block” in Word Help to learn more.

If an alert message about building blocks appears when you quit Word, see Section 16.17, “An
Alert about Building Blocks Appears When Word Quits” on page 71.
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Chapter 14

Setting Preferences

Set Contract Tools to be turned off when you open documents.
Learn about other ways to customize how you work with
Contract Tools.

You can set Contract Tools preferences by using the controls in the Preferences view. To show
the Preferences view, click the Preferences button at the top of the Contract Tools pane.

Here are preferences you may want to change:

By default, this happens To make this happen Do this To learn more, go to

Contract Tools turns on
automatically when
documents open

Set Contract Tools to be
turned off

Deselect “Turn on when
documents open”

Section 2.1, “The
Contract Tools Ribbon
Tab” on page 13

The Contract Tools pane
appears on the right of
the Word window

Set the Contract Tools
pane to be hidden or
appear on the left

Use the Contract Tools
Pane controls

Section 2.5, “The
Contract Tools Pane” on
page 16

Contract Tools analyzes
when you save

Analyze manually Deselect “Analyze when
saving” below Analysis

Section 3.2, “Updating
Analysis” on page 22

Defined terms, drafting
errors, and other content
are highlighted

Hide highlighting; use
underlining instead of
highlighting

Use the Highlighting &
Underlining controls

Section 2.3, “Highlighting
Content” on page 15

A warning appears to
confirm deleting snippets

Delete snippets without
showing a warning

Deselect “Show warning
before deleting” below
Snippets

Chapter 13, “Working
with Snippets” on
page 53

Unused defined terms,
to-dos, and other items
appear in the Issues
pop-up menu

Exclude items from the
Issues pop-up menu

Use the Issues Pop-Up
Menu controls

Section 2.5.4, “The Issues
Pop-Up Menu” on
page 19
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Chapter 15

Deactivation, Subscription
Management, and Uninstalling

Deactivate Contract Tools on your current computer to activate it
on a different computer. Disconnect from your organization’s
license server. Update your billing information. Cancel your
subscription. Uninstall Contract Tools to remove it from your
computer.

To learn about Go to

Using Contract Tools on a different computer Section 15.1, “Deactivating Contract Tools” on this
page

Allowing others to use Contract Tools when your
organization uses Contract Tools License Server

Section 15.2, “Disconnecting from Contract Tools
License Server” on the next page

Updating your billing information; canceling your
Contract Tools subscription

Section 15.3, “Managing Your Contract Tools
Subscription” on the next page

Removing Contract Tools from your computer Section 15.4, “Uninstalling Contract Tools” on
page 59

15.1 Deactivating Contract Tools
If you want to activate Contract Tools on a different computer, you should first deactivate
Contract Tools on your current computer.

Here are ways to deactivate Contract Tools:

• If you have a Contract Tools subscription, show the Contract Tools pane, click the Subscription
button, and then click Deactivate.

• If you don’t have a Contract Tools subscription, show the Contract Tools pane, and then click
Deactivate.
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Note:When you deactivate Contract Tools, you do not cancel your subscription; see
Section 15.3, “Managing Your Contract Tools Subscription” on this page to learn how to cancel
your subscription. Also, when you deactivate Contract Tools, you do not remove it from your
computer; see Section 15.4, “Uninstalling Contract Tools” on the next page to learn how to
remove Contract Tools from your computer.

To learn how to activate Contract Tools, see Section 1.3, “Activating Contract Tools” on page 8.

If you forget to deactivate Contract Tools on one computer before you try to activate it on
another, you can deactivate Contract Tools on your other computers when you activate
Contract Tools on your current computer.

To deactivate Contract Tools on your other computers:

1. On your current computer, enter your activation key, and then click Activate; see Section 1.3,
“Activating Contract Tools” on page 8 to learn more. An alert message that says “Do you want
to deactivate Contract Tools on all of your computers?” appears.

2. Click Yes to deactivate Contract Tools on your other computers and activate Contract Tools on
your current computer. If you change your mind about deactivating Contract Tools on your
other computers, click No.

To troubleshoot problems with deactivating Contract Tools, see Section 16.7, “Contract Tools
Cannot Connect to the Internet” on page 65.

15.2 Disconnecting from Contract Tools License Server
If your organization uses Contract Tools License Server to administer Contract Tools, you may
want to disconnect Contract Tools from the server to allow others within your organization to
use Contract Tools.

Here are ways to disconnect Contract Tools from Contract Tools License Server:

• Show the Contract Tools pane, click the Subscription button, and then click Disconnect.

• Quit Word.

To learn how to connect to Contract Tools License Server, see Section 1.5, “Connecting to
Contract Tools License Server” on page 10.

15.3 Managing Your Contract Tools Subscription
You can update your billing information or cancel your Contract Tools subscription.

Here are ways to manage your Contract Tools subscription:

• Show the Contract Tools pane, click the Subscription button, and then click Manage
Subscription.

• Click the link that appears below the Order ID in your billing confirmation emails.

To transfer your Contract Tools subscription to another computer, you can deactivate Contract
Tools on your current computer, and then activate Contract Tools on another computer; see
Section 15.1, “Deactivating Contract Tools” on the previous page and Section 1.3, “Activating
Contract Tools” on page 8 to learn how.
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15.4 Uninstalling Contract Tools
You can uninstall Contract Tools to remove it from your computer.

Before you uninstall Contract Tools, you should deactivate it; see Section 15.1, “Deactivating
Contract Tools” on page 57 to learn how.

Here are ways to uninstall Contract Tools:

• In Windows 11, open Settings, choose Apps > Installed apps, find Paper Software Contract Tools
in the app list, click the More Actions button (looks like three dots) next to Paper Software
Contract Tools, and then choose Uninstall.

• In any version of Windows, open Control Panel, click “Uninstall a program” at the bottom left,
find Paper Software Contract Tools in the list of programs, select it, and then click Uninstall at
the top of the list.

Note:When you uninstall Contract Tools, you do not cancel your subscription; see Section 15.3,
“Managing Your Contract Tools Subscription” on the previous page to learn how to cancel your
subscription.

It’s possible to remove Contract Tools fromWord by using Word’s COM Add-ins dialog (to show
this, choose File > Options > Add-ins to show the Add-ins pane of Word Options, choose COM
Add-ins from the Manage pop-up menu at the bottom of the Add-ins pane, and then click Go).
Removing Contract Tools fromWord is not a good idea. Doing this may permanently prevent
Word from loading Contract Tools, even if you reinstall Contract Tools. To undo removing
Contract Tools fromWord, you may need to perform an online repair of Office; visit Repair an
Office application (https://support.microsoft.com/en-us/office/
repair-an-office-application-7821d4b6-7c1d-4205-aa0e-a6b40c5bb88b) to learn more. You
should uninstall Contract Tools instead of removing it fromWord.
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Chapter 16

Troubleshooting

Learn how to solve problems with Contract Tools. Find version
information for Windows, Word, and Contract Tools.

Here are tips for resolving issues that might arise when you use Contract Tools.

To learn about this issue Go to

Contract Tools Setup stops when downloading
prerequisites

Section 16.1, “Contract Tools Setup Won’t
Download Prerequisites” on the next page

A Program Compatibility Assistant alert appears
during Contract Tools installation

Section 16.2, “Program Compatibility Assistant
Appears after Installing Contract Tools” on page 62

Contract Tools doesn’t start, but no alert messages
appear

Section 16.3, “Contract Tools Won’t Start” on
page 62

Contract Tools doesn’t start, and an alert message
appears

Section 16.4, “Contract Tools Won’t Start Due to an
Error” on page 63

The Contract Tools pane doesn’t appear, even
though the Contract Tools ribbon tab appears

Section 16.5, “The Contract Tools Pane Won’t
Appear” on page 64

Parts of the Contract Tools pane are black;
highlighting is misaligned

Section 16.6, “The Contract Tools Pane Appears
with Black Shapes; Highlighting Is Misplaced” on
page 64

Activating, deactivating, or beginning a trial fails
because Contract Tools can’t connect to the
internet

Section 16.7, “Contract Tools Cannot Connect to
the Internet” on page 65

Activating or beginning a trial fails because of a
problem with network adapters

Section 16.8, “Contract Tools Won’t Activate Due to
Disabled Network Adapters” on page 66

Activating or beginning a trial fails because of a
problem with Windows Management
Instrumentation (WMI)

Section 16.9, “Contract Tools Won’t Activate Due to
a Problem with Windows Management
Instrumentation” on page 66
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To learn about this issue Go to

A message about connecting to your organization’s
license server appears at the top of the Contract
Tools pane

Section 16.10, “Contract Tools Cannot Connect to a
License Server” on page 67

Word becomes unresponsive when Contract Tools
analyzes a document created from a PDF

Section 16.11, “Analyzing a Document Converted
from a PDF Takes a Long Time” on page 67

Contract Tools doesn’t find provisions, defined
terms, and other items that appear in your
document

Section 16.12, “Contract Tools Won’t Find Content”
on page 68

A document doesn’t appear in the “Include from”
pop-up menu in the Analysis Settings view

Section 16.13, “Including Defined Terms from
Another Document Is Impossible” on page 68

The New button in the Snippets view is always
disabled

Section 16.14, “Creating Snippets Is Impossible” on
page 69

A Word window shared using Microsoft Teams
appears mostly black

Section 16.15, “Documents Appear Black When
Sharing Word Windows Using Microsoft Teams” on
page 70

Word becomes unresponsive when closing a
document

Section 16.16, “Closing a Document Takes a Long
Time When Using Multiple Add-Ins” on page 70

An alert about modified content in Building Blocks
appears when quitting Word

Section 16.17, “An Alert about Building Blocks
Appears When Word Quits” on page 71

Word becomes unresponsive when quitting on a
touch or stylus device

Section 16.18, “Quitting Word Takes a Long Time
on a Computer with a Touchscreen or Stylus” on
page 72

Word shuts down unexpectedly when using
Contract Tools and other add-ins on a touch or
stylus device

Section 16.19, “Word Quits Unexpectedly When
Using Multiple Add-Ins on a Computer with a
Touchscreen or Stylus” on page 72

Contract Tools can’t be updated, and an alert
message appears

Section 16.20, “Contract Tools Won’t Install
Updates” on page 72

To help you resolve an issue with Contract Tools, we may need information about your
computer and the software you use; see Section 16.21, “Finding Information about Your
Computer” on page 73 to learn more.

See Section 16.22, “Disabling Word Add-Ins” on page 74 to learn how to disable a Word add-in.

16.1 Contract Tools Setup Won’t Download Prerequisites
What happens: When you’re installing Contract Tools (see Section 1.1, “Installing Contract
Tools” on page 7), “Downloading prerequisite software” appears in the Contract Tools Setup
window, and a progress indicator (a moving bar) shows the status of the download. The
progress indicator doesn’t move.

What this means: When you install Contract Tools, you also download and install other
Microsoft software that Contract Tools requires (see Section 1.10, “Prerequisites for Installing
Contract Tools” on page 12 to learn more). Most likely, firewall software (or similar software) is
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preventing Contract Tools Setup from downloading this software.

What you should do: Temporarily disable your firewall software, or configure it to allow
Contract Tools Setup to connect to the internet. The documentation for your firewall software
should have instructions on how to do this. As an alternative, you can download and install
Contract Tools’ prerequisites. For information about Contract Tools’ prerequisites, including
links to installers, see Section 1.10, “Prerequisites for Installing Contract Tools” on page 12.

16.2 Program Compatibility Assistant Appears after Installing
Contract Tools

What happens: When Contract Tools Setup is finished, a Program Compatibility Assistant alert
appears. The alert says that Visual Studio Tools for Office Solution Installer “might not have
installed correctly”.

What this means: Program Compatibility Assistant (PCA) is Microsoft software that detects
when installers or setup programs fail to install software correctly; see Application Compatibility:
Program Compatibility Assistant (PCA)
(https://docs.microsoft.com/en-us/previous-versions/bb756937(v=msdn.10)) to learn more.
PCA has incorrectly categorized Visual Studio Tools for Office Solution Installer as a setup
program.

What you should do: Click Cancel to dismiss the alert, or click “This program installed correctly”
to prevent the alert from appearing again.

16.3 Contract Tools Won’t Start
What happens: When you open a document in Word, both the Contract Tools ribbon tab and
the Contract Tools pane fail to appear (see Section 2.1, “The Contract Tools Ribbon Tab” on
page 13 and Section 2.5, “The Contract Tools Pane” on page 16). No Contract Tools alert
messages appear.

What this means: It’s possible that Contract Tools failed to install, or that Contract Tools has
been uninstalled (see Section 15.4, “Uninstalling Contract Tools” on page 59). It’s also possible
that Contract Tools is disabled in Word.

What you should do: Confirm that Contract Tools is installed on your computer and enabled in
Word.

To confirm that Contract Tools is installed:

1. Show a list of applications on your computer. Here are ways to do this:

• In Windows 11, open Settings and choose Apps > Installed apps.

• In any version of Windows, open Control Panel and click “Uninstall a program” at the
bottom left.

2. Make sure that Paper Software Contract Tools appears in the list of applications.

See Section 1.1, “Installing Contract Tools” on page 7 to learn how to install Contract Tools.

Note: On computers with Word 2007, make sure that Contract Tools is installed only for you,
not for everyone who uses your computer. A simple way to do this is to uninstall and reinstall
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Contract Tools; see Section 15.4, “Uninstalling Contract Tools” on page 59 and Section 1.1,
“Installing Contract Tools” on page 7 to learn how.

To confirm that Contract Tools is enabled in Word:

1. Choose File > Options > Add-ins to show the Add-ins pane of Word Options.

2. Make sure that Paper Software Contract Tools appears below Active Application Add-ins in the
list of add-ins.

See Section 1.7, “Enabling Contract Tools” on page 11 to learn how to enable Contract Tools.

Note: If Contract Tools was removed fromWord using Word’s COM Add-ins dialog, Contract
Tools may not appear in Word’s list of add-ins, even if Contract Tools is installed on your
computer. To enable Contract Tools when it has been removed fromWord, you may need to
perform an online repair of Office; visit Repair an Office application (https://support.microsoft.
com/en-us/office/repair-an-office-application-7821d4b6-7c1d-4205-aa0e-a6b40c5bb88b) to
learn more. You should uninstall Contract Tools instead of removing it fromWord; see
Section 15.4, “Uninstalling Contract Tools” on page 59 to learn how.

If Contract Tools still won’t start after confirming that it’s installed and enabled, email
support@papersoftware.com.

If an alert message about Contract Tools appears when Word starts, see Section 16.4, “Contract
Tools Won’t Start Due to an Error” on this page. If the Contract Tools pane doesn’t appear even
though the Contract Tools ribbon tab appears, see Section 16.5, “The Contract Tools Pane
Won’t Appear” on the next page.

16.4 Contract Tools Won’t Start Due to an Error
What happens: When you open Word, an alert message about Contract Tools appears. The
Contract Tools ribbon tab (see Section 2.1, “The Contract Tools Ribbon Tab” on page 13) fails to
appear, or appears with most buttons disabled. The Contract Tools pane (see Section 2.5, “The
Contract Tools Pane” on page 16) fails to appear.

What this means: It’s possible that a Contract Tools prerequisite is missing; see Section 1.10,
“Prerequisites for Installing Contract Tools” on page 12 for a list of prerequisites. It’s also
possible that the file in which Contract Tools preferences are saved is damaged.

What you should do: Make sure that Contract Tools’ prerequisites are installed. A simple way
to do this is to uninstall and reinstall Contract Tools; see Section 15.4, “Uninstalling Contract
Tools” on page 59 and Section 1.1, “Installing Contract Tools” on page 7 to learn how. If this
doesn’t resolve the issue, you can make Word create a new, undamaged Contract Tools
preferences file with default preferences.

To make Word create a new Contract Tools preferences file:

1. Quit Word.

2. Open File Explorer and go to C:\Users\[Your User Name]\AppData\Local\Microsoft_Corporation.
If you can’t see the AppData folder, choose View > Show > Hidden items in File Explorer.

3. In the Microsoft_Corporation folder, there should be a subfolder with a name that begins with
PaperSoftwareContractTool_. Move this subfolder to the Recycle Bin. (This subfolder is created
and managed by Word. It contains subfolders named with Word version numbers, and each of
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these subfolders contains a file named user.config. These files contain the preferences you set
in the Preferences view.)

4. Open a document in Word to start Contract Tools.

If Contract Tools still won’t start, email support@papersoftware.com.

If no alert messages appear when you open Word but Contract Tools still fails to start, see
Section 16.3, “Contract Tools Won’t Start” on page 62. If the Contract Tools pane doesn’t appear
even though the Contract Tools ribbon tab appears as expected, see Section 16.5, “The Contract
Tools Pane Won’t Appear” on this page.

16.5 The Contract Tools Pane Won’t Appear
What happens: When you open a document in Word, the Contract Tools pane fails to appear,
even though the Contract Tools ribbon tab appears (see Section 2.5, “The Contract Tools Pane”
on page 16 and Section 2.1, “The Contract Tools Ribbon Tab” on page 13). When you click the
Contract Tools Pane button in the Contract Tools ribbon tab, the Contract Tools pane doesn’t
appear.

What this means: Most likely, another add-in is changing the default behavior of Word such
that the Contract Tools pane cannot appear. (Litéra LexPro has been reported to cause this
behavior.)

What you should do: Disable your other Word add-ins and see whether this resolves the issue.
To learn how to disable a Word add-in, see Section 16.22, “Disabling Word Add-Ins” on page 74.

If the Contract Tools pane still won’t appear, email support@papersoftware.com.

If both the Contract Tools ribbon tab and the Contract Tools pane fail to appear, see
Section 16.3, “Contract Tools Won’t Start” on page 62 and Section 16.4, “Contract Tools Won’t
Start Due to an Error” on the previous page. If the Contract Tools pane is concealed by black
shapes, see Section 16.6, “The Contract Tools Pane Appears with Black Shapes; Highlighting Is
Misplaced” on this page.

16.6 The Contract Tools Pane Appears with Black Shapes;
Highlighting Is Misplaced

What happens: The Contract Tools pane (see Section 2.5, “The Contract Tools Pane” on
page 16) is partially covered by black rectangles. Highlighting (see Section 2.3, “Highlighting
Content” on page 15) is not aligned with text in your document.

What this means: Most likely, the scale of your computer’s display has changed since you
signed in to Windows. A Display Settings button may appear at the bottom of the Word
window when this happens. Your display’s scale may change when you connect your computer
to an additional display or disconnect it from an additional display. Also, in Windows 11, you can
change your display’s scale in Settings (choose System > Display).

What you should do: Sign out of Windows (or restart your computer), sign in to Windows, and
then open Word.

Here are ways to sign out of Windows 11:

• Show the Start menu, click your user name at the bottom left, and then choose “Sign out”.
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• Right-click the Start button and choose Shut down or sign out > Sign out.

As an alternative, in Word 2016 and later (including Word for Microsoft 365), you can adjust
Word options: choose File > Options > General, and then select “Optimize for compatibility”.
Visit Office support for high definition displays (https://support.microsoft.com/en-us/office/
office-support-for-high-definition-displays-6720ca0e-be59-41f6-b629-1369f549279d) to learn
more.

If black rectangles still appear in the Contract Tools pane or if highlighting still appears in the
wrong place, email support@papersoftware.com.

If the Contract Tools pane fails to appear, see Section 16.5, “The Contract Tools Pane Won’t
Appear” on the previous page. If both the Contract Tools ribbon tab and the Contract Tools
pane fail to appear, see Section 16.3, “Contract Tools Won’t Start” on page 62 and Section 16.4,
“Contract Tools Won’t Start Due to an Error” on page 63.

16.7 Contract Tools Cannot Connect to the Internet
What happens: When you try to activate, deactivate, or begin a trial of Contract Tools, an alert
message that says “Contract Tools cannot connect to the internet” appears.

What this means: To begin a trial and to become activated or deactivated, Contract Tools must
connect to the internet. Most likely, antivirus or firewall software on your computer or network
is preventing Word from connecting to the internet (because Contract Tools is a Word add-in,
Contract Tools connects to the internet through Word). It’s also possible that your computer
isn’t connected to the internet or that the website of Contract Tools’ license management
system (https://wyday.com) is being blocked. If you connect to the internet through a proxy,
you may need to change Contract Tools’ proxy settings.

What you should do: Make sure that your computer is connected to the internet, that you can
visit https://wyday.com using Edge or Internet Explorer, and that antivirus and firewall
software is configured to allow Word to connect to the internet. If you connect to the internet
through a proxy, make sure Contract Tools’ proxy settings are properly configured.

To diagnose and resolve this issue:

1. Make sure your computer is connected to the internet. One way to do this is to use a web
browser to go to a website you visit regularly. If you can’t visit this website, connect to the
internet, and then try to activate, deactivate, or begin a trial of Contract Tools again.

2. If your computer is connected to the internet, try using Edge or Internet Explorer to visit
https://wyday.com, the website of Contract Tools’ license management system. (It’s important
to use Edge or Internet Explorer because Contract Tools’ license management system uses the
same proxies that Edge and Internet Explorer use.) If you can’t visit https://wyday.com using
Edge or Internet Explorer, ask your network administrator to unblock wyday.com.

3. If you connect to the internet through a proxy, you may need to change Contract Tools’ proxy
settings. To do this, use the Proxy Settings controls. Your network administrator can provide
the proxy settings you should use.

4. If you can visit https://wyday.com, then most likely, antivirus or firewall software is preventing
Word from connecting to the internet. To identify antivirus or firewall software that’s causing
this issue, temporarily disable this software, and then try to activate, deactivate, or begin a trial
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of Contract Tools again. The documentation for your antivirus or firewall software should have
instructions on how to configure it to allow Word to connect to the internet.

If Contract Tools still cannot connect to the internet, email support@papersoftware.com.

Instead of activating Contract Tools over the internet, you can activate Contract Tools offline;
see Section 1.3.2, “Activating Offline” on page 9 to learn how.

If you need to use Contract Tools without connecting to the internet, email
info@papersoftware.com to learn about deployment options.

If an alert message about enabling network adapters appears, see Section 16.8, “Contract Tools
Won’t Activate Due to Disabled Network Adapters” on this page. If an alert message about
Windows Management Instrumentation appears, see Section 16.9, “Contract Tools Won’t
Activate Due to a Problem with Windows Management Instrumentation” on this page.

16.8 Contract Tools Won’t Activate Due to Disabled Network
Adapters

What happens: When you try to activate or begin a trial of Contract Tools in Windows 7, this
alert message appears: “To activate or begin a trial of Contract Tools, you must enable all of
your computer’s network adapters.”

What this means: To prevent unauthorized use, Contract Tools’ license management system
creates a profile of your computer’s hardware. This profile must include your computer’s
network adapters. In Windows 7, Contract Tools’ license management system cannot profile
disabled network adapters, so it cannot create a profile of your computer’s hardware if network
adapters are disabled.

What you should do: Enable any disabled network adapters, and then try to activate or begin a
trial of Contract Tools again. As an alternative, update to Windows 8.1 or later.

To enable network adapters:

1. Open Control Panel, and then choose Network and Internet > Network and Sharing Center >
Change adapter settings.

2. Right-click any disabled network adapters (highlighted in gray), and then choose Enable.

If an alert message about connecting to the internet appears, see Section 16.7, “Contract Tools
Cannot Connect to the Internet” on the previous page. If an alert message about Windows
Management Instrumentation appears, see Section 16.9, “Contract Tools Won’t Activate Due to
a Problem with Windows Management Instrumentation” on this page.

16.9 Contract Tools Won’t Activate Due to a Problem with
Windows Management Instrumentation

What happens: When you try to activate or begin a trial of Contract Tools, an alert message
about re-enabling Windows Management Instrumentation (WMI) appears.

What this means: Windows Management Instrumentation is Microsoft software that Contract
Tools and other Windows applications require. Either Windows Management Instrumentation
is disabled, or a Windows configuration problem is preventing Windows Management
Instrumentation from working as expected.
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What you should do: Make sure that Windows Management Instrumentation is running. You
may need an administrator account to do this. If this doesn’t resolve the issue, other resources
are available to help you troubleshoot problems with Windows Management Instrumentation.

To confirm that Windows Management Instrumentation is running:

1. View local services. One way to do this in Windows 11 is to open Control Panel, choose System
and Security > Windows Tools, and then open Services.

2. Double-click Windows Management Instrumentation in the list of services.

3. Make sure that the “Startup type” pop-up menu is set to Automatic. If Running does not appear
to the right of “Service status”, click Start or Resume.

To troubleshoot problems with Windows Management Instrumentation, you can use Windows
Management Instrumentation Tester. To use this program, enter wbemtest in PowerShell or
Command Prompt. Additional resources for troubleshooting problems with Windows
Management Instrumentation are available at WMI Troubleshooting
(https://docs.microsoft.com/en-us/windows/win32/wmisdk/wmi-troubleshooting).

If an alert message about connecting to the internet appears, see Section 16.7, “Contract Tools
Cannot Connect to the Internet” on page 65. If an alert message about enabling network
adapters appears, see Section 16.8, “Contract Tools Won’t Activate Due to Disabled Network
Adapters” on the previous page.

16.10 Contract Tools Cannot Connect to a License Server
What happens: A message that says “Contract Tools cannot connect to your organization’s
license server” appears at the top of the Contract Tools pane.

What this means: Contract Tools is configured to connect to your organization’s license server
automatically, but Contract Tools can connect to a license server only if your computer and the
license server are connected to the same network. Most likely, your computer is not connected
to the same network as your organization’s license server. It’s also possible that the license
server’s address and port are misconfigured.

What you should do: Make sure your computer is connected to your organization’s network
(through a VPN, for example), and then try to connect to the license server again (a simple way
to do this is to reopen Word). Your network administrator can help with connecting to your
organization’s network, and your system administrator can help with configuring your
organization’s license server.

For general information about connecting to a license server, see Section 1.5, “Connecting to
Contract Tools License Server” on page 10.

16.11 Analyzing a Document Converted from a PDF Takes a
Long Time

What happens: When Contract Tools analyzes a Word document converted from a PDF,
analysis takes a long time, and Word may temporarily become unresponsive (freeze, hang).

What this means: Word documents converted from PDFs using some third-party conversion
applications may include numerous, slight formatting adjustments. In some cases, every
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character (letter) in a converted Word document may be formatted individually. The way in
which these formatting adjustments are implemented in Word documents can make analysis
take a long time, especially in Word 2013 and later.

What you should do: Use Word 2013 or later instead of a third-party conversion application to
convert PDFs to Word documents; search for “opening PDFs” in Word Help to learn how. As an
alternative, copy text in the converted Word document, paste unformatted text into a new
Word document, and then analyze this new Word document. To learn how to paste
unformatted text, search for “paste text only” in Word Help.

For general information about analysis, see Chapter 3, “Analyzing Documents” on page 21.

16.12 Contract Tools Won’t Find Content
What happens: When Contract Tools analyzes your document, it fails to find provisions,
defined terms, and other content, even though these items appear in your document.

What this means: It’s possible that Contract Tools is analyzing only a part of your document;
see Section 3.3, “Analyzing Part of a Document” on page 23 to learn more. It’s also possible that
your document is laid out using tables. By default, Contract Tools doesn’t analyze content
within tables.

What you should do: Make Contract Tools analyze your entire document, or choose the part of
your document that you want Contract Tools to analyze; see Section 3.3, “Analyzing Part of a
Document” on page 23 to learn how. If your document is laid out using tables, make Contract
Tools analyze content within tables; see Section 3.6, “Analyzing Tables” on page 25 to learn how.

16.13 Including Defined Terms from Another Document Is
Impossible

What happens: A document with defined terms that you want to include in your main
document (see Section 5.2, “Including Defined Terms from Another Document” on page 30 to
learn more) doesn’t appear in the “Include from” pop-up menu in the Analysis Settings view.

What this means: It’s possible that the document with the defined terms that you want to
include is closed or new. To include defined terms from another document, it must be open in
Word and it must not be a new, unsaved document.

If the document with the defined terms that you want to include is open in Word and saved,
then most likely, this document and your main document are open in separate instances of
Word. To include defined terms from another document in your main document, both
documents must be open in the same instance of Word.

In Word 2016 and later (including Word for Microsoft 365), documents may open in separate
instances of Word if you quickly open documents while Word is closed (for example, by
double-clicking documents in File Explorer).

What you should do: Make sure the document with the defined terms that you want to
include in your main document is open in Word and saved. Also, make sure both documents are
open in the same instance of Word. If you’re working with two documents in two instances of
Word, a generally reliable way to do this is to close one of the documents and Word instances
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by clicking the Close button (×) at the top right of a Word window, and then reopen the
document you closed. If Word’s opening display (splash screen) does not appear when you
reopen this document, it’s opening in the same instance of Word as the other document.

Here are ways to open documents in the same instance of Word:

• Double-click a document in File Explorer to open Word, wait for the document to appear in a
Word window, and then double-click another document in File Explorer.

• Double-click a document in File Explorer to open Word, and then open another document
using Word’s controls; search for “open file” in Word Help to learn how.

• Open Word by clicking its icon in the taskbar or the Start menu, and then open documents
using Word’s controls.

Here are ways to see howmany instances of Word are open:

• Use Task Manager; search the internet for “Windows Task Manager” to learn how.

• Use PowerShell or Command Prompt. For example, enter in PowerShell:

Get-Process WINWORD

or in Command Prompt:

tasklist /fi "IMAGENAME eq WINWORD.EXE"

If the output contains more than one instance of WINWORD or WINWORD.EXE, more than one
instance of Word is open.

16.14 Creating Snippets Is Impossible
What happens: The New button at the bottom of the Snippets view is always disabled, even
when text in your document is selected. The Convert commands in the Action pop-up menu at
the bottom of the Snippets view are disabled.

What this means: In Contract Tools, the file in which snippets are saved is called a snippets file.
When Contract Tools starts for the first time, it attempts to create a snippets file in a folder
from which Word loads building blocks. Either Contract Tools couldn’t create this file, or the file
was moved or deleted. It’s also possible that the file is saved in a folder from which Word does
not load building blocks.

What you should do: Choose or create a snippets file in a folder from which Word loads
building blocks.

To choose or create a snippets file:

1. Show the Contract Tools pane, click the Preferences button, and then click Snippets File.

2. Click Choose to choose an existing snippets file or click New to create a new one.

3. Reopen Word.

The snippets file must be saved in a folder from which Word loads building blocks. Generally,
this folder is %APPDATA%\Microsoft\Document Building Blocks\[Locale Identifier]\[Word Version].

• %APPDATA% is a shorthand for the path of a folder in which Windows applications can
save data. This path is usually C:\Users\[Your User Name]\AppData\Roaming. If you can’t
see this folder, open File Explorer and choose View > Show > Hidden items.
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• [Locale Identifier] is a number that identifies a language used by Word. For example, 1033
means US English. For more information about locale identifiers, see these resources:

For these versions of Word See

Word 2016 and later
(including Word for
Microsoft 365)

Language identifiers and OptionState Id values in Office 2016
(https://docs.microsoft.com/en-us/deployoffice/office2016/
language-identifiers-and-optionstate-id-values-in-office-2016#
language-identifiers)

Word 2013 Language identifiers and OptionState Id values in Office 2013
(https://docs.microsoft.com/en-us/previous-versions/office/
office-2013-resource-kit/cc179219(v=office.15)#language-identifiers)

Word 2010 Language identifiers and OptionState Id values in Office 2010
(https://docs.microsoft.com/en-us/previous-versions/office/
office-2010/cc179219(v=office.14)#language-identifiers)

• [Word Version] is 16 for Word 2016 and later (including Word for Microsoft 365), 15 for
Word 2013, and 14 for Word 2010.

For general information about snippets, see Chapter 13, “Working with Snippets” on page 53.
To learn how snippets in Contract Tools relate to building blocks in Word, see Section 13.5,
“Snippets and Building Blocks” on page 55.

16.15 Documents Appear Black When Sharing Word Windows
Using Microsoft Teams

What happens: When you share a Word window using Microsoft Teams, the people with
whom you’re sharing see a black rectangle instead of your document.

What this means: Contract Tools uses an overlay to apply highlighting (see Section 2.3,
“Highlighting Content” on page 15) without changing your document. Some versions of
Microsoft Teams can cause this overlay to appear as a black rectangle when sharing a Word
window.

What you should do: Update Microsoft Teams to the latest version; visit Update Microsoft Teams
(https://support.microsoft.com/en-us/office/
update-microsoft-teams-535a8e4b-45f0-4f6c-8b3d-91bca7a51db1) to learn how. If Microsoft
Teams cannot be updated, you can share your desktop instead of a Word window, or turn off
Contract Tools while sharing a Word window; see Section 2.1, “The Contract Tools Ribbon Tab”
on page 13 to learn how to turn off Contract Tools. For help using Microsoft Teams, visit
Microsoft Teams help & learning (https://support.microsoft.com/en-us/teams).

16.16 Closing a Document Takes a Long TimeWhen Using
Multiple Add-Ins

What happens: While using Contract Tools and other Word add-ins, Word temporarily
becomes unresponsive (freezes, hangs) when closing a document.

What this means: Most likely, another add-in is causing Word to perform a time-consuming
and unnecessary task with data that Contract Tools uses to sync analysis results with

70

https://docs.microsoft.com/en-us/deployoffice/office2016/language-identifiers-and-optionstate-id-values-in-office-2016#language-identifiers
https://docs.microsoft.com/en-us/deployoffice/office2016/language-identifiers-and-optionstate-id-values-in-office-2016#language-identifiers
https://docs.microsoft.com/en-us/deployoffice/office2016/language-identifiers-and-optionstate-id-values-in-office-2016#language-identifiers
https://docs.microsoft.com/en-us/deployoffice/office2016/language-identifiers-and-optionstate-id-values-in-office-2016#language-identifiers
https://docs.microsoft.com/en-us/previous-versions/office/office-2013-resource-kit/cc179219(v=office.15)#language-identifiers
https://docs.microsoft.com/en-us/previous-versions/office/office-2013-resource-kit/cc179219(v=office.15)#language-identifiers
https://docs.microsoft.com/en-us/previous-versions/office/office-2013-resource-kit/cc179219(v=office.15)#language-identifiers
https://docs.microsoft.com/en-us/previous-versions/office/office-2010/cc179219(v=office.14)#language-identifiers
https://docs.microsoft.com/en-us/previous-versions/office/office-2010/cc179219(v=office.14)#language-identifiers
https://docs.microsoft.com/en-us/previous-versions/office/office-2010/cc179219(v=office.14)#language-identifiers
https://support.microsoft.com/en-us/office/update-microsoft-teams-535a8e4b-45f0-4f6c-8b3d-91bca7a51db1
https://support.microsoft.com/en-us/office/update-microsoft-teams-535a8e4b-45f0-4f6c-8b3d-91bca7a51db1
https://support.microsoft.com/en-us/office/update-microsoft-teams-535a8e4b-45f0-4f6c-8b3d-91bca7a51db1
https://support.microsoft.com/en-us/teams
https://support.microsoft.com/en-us/teams


documents while there are unanalyzed changes. iManage Integration for Office, a Word add-in
distributed with some versions of iManage FileSite and DeskSite, can cause this behavior.

What you should do: If you use iManage Integration for Office, you may be able to resolve this
issue by creating a Registry value; see Appendix B, “Configuring iManage Software” on page 81
to learn more. As an alternative, you can disable the add-in that’s causing the issue; see
Section 16.22, “Disabling Word Add-Ins” on page 74 to learn how. If you can’t disable the add-in
that’s causing the issue, you can disable syncing while there are unanalyzed changes.

To disable syncing while there are unanalyzed changes:

• Show the Contract Tools pane, click the Preferences button, and then deselect the “Sync
analysis results with unanalyzed changes” checkbox.

To learn how to reanalyze your document when there are unanalyzed changes, see Section 3.2,
“Updating Analysis” on page 22.

If Word temporarily becomes unresponsive when quitting on a computer with a touchscreen or
a stylus, see Section 16.18, “Quitting Word Takes a Long Time on a Computer with a
Touchscreen or Stylus” on the next page.

16.17 An Alert about Building Blocks Appears WhenWord
Quits

What happens: When you quit Word, this alert message appears: “You have modified styles,
building blocks (such as cover pages or headers) or other content that is stored in "Building
Blocks". Do you wish to save changes to "Building Blocks"?” This alert message appears even
though you didn’t modify content stored in Building Blocks.

What this means: By default, starting Contract Tools causes Word to load building blocks
(search for “building block” in Word Help to learn more). When some versions of Word 2016
and later (including Word for Microsoft 365) load building blocks, they incorrectly assume that
building blocks stored in a file named Building Blocks.dotx have been modified. Visit Archived
Release notes for Monthly Channel releases, Version 1912: January 08 (https://docs.microsoft.com/
en-us/officeupdates/monthly-channel-archived#version-1912-january-08) for a description of
this issue and its resolution by Microsoft Support.

What you should do: To dismiss the alert message and quit Word, click Save or Don't Save. To
stop the alert message from appearing, update Word; search for “install Office updates” in
Word Help to learn how. If you can’t update Word, you can mitigate this issue by configuring
Contract Tools not to load snippets when it starts.

To configure Contract Tools not to load snippets when it starts:

• Show the Contract Tools pane, click the Preferences button, click Snippets File, and then
deselect the “Load when Contract Tools starts” checkbox.

Note: Even if Contract Tools is configured not to load snippets when it starts, causing affected
versions of Word to load building blocks (for example, by showing the Snippets view, or by
choosing Insert > Quick Parts) will cause the Building Blocks alert message to appear when
Word quits.

For general information about snippets, see Chapter 13, “Working with Snippets” on page 53.
To learn how snippets in Contract Tools relate to building blocks in Word, see Section 13.5,
“Snippets and Building Blocks” on page 55.
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16.18 Quitting Word Takes a Long Time on a Computer with a
Touchscreen or Stylus

What happens: When you quit Word on a computer with a touchscreen or a stylus, Word
temporarily becomes unresponsive (freezes, hangs).

What this means: Most likely, this behavior is attributable to an issue with some versions of
Visual Studio 2010 Tools for Office Runtime (see Section 1.10, “Prerequisites for Installing
Contract Tools” on page 12 to learn about other Contract Tools prerequisites). Visit Update rollup
for Visual Studio 2010 Tools for Office Runtime (https://support.microsoft.com/en-us/help/
3001652/update-rollup-for-visual-studio-2010-tools-for-office-runtime) for a description of
this issue and its resolution by Microsoft Support.

What you should do: Update Visual Studio 2010 Tools for Office Runtime to a more recent
version. An installer for version 10.0.60917, released February 22, 2024, is available at
https://www.microsoft.com/en-us/download/details.aspx?id=105890.

If Word temporarily becomes unresponsive when closing documents while using Contract Tools
and other Word add-ins, see Section 16.16, “Closing a Document Takes a Long Time When
Using Multiple Add-Ins” on page 70. If Word quits unexpectedly on a computer with a
touchscreen or a stylus, see Section 16.19, “Word Quits Unexpectedly When Using Multiple
Add-Ins on a Computer with a Touchscreen or Stylus” on this page.

16.19 Word Quits Unexpectedly When Using Multiple Add-Ins
on a Computer with a Touchscreen or Stylus

What happens: While using Contract Tools and other Word add-ins on a computer with a
touchscreen or a stylus, Word quits unexpectedly (crashes).

What this means: Because of a problem with Windows Presentation Foundation (WPF) and
Microsoft software used on touch and stylus devices, Word may quit unexpectedly while using
multiple Word add-ins on tablet computers and similar devices if some add-ins require .NET
Framework 4 or later and others require .NET Framework 3.5 or earlier. (Contract Tools
requires .NET Framework with a version between 4.5.2 and 4.8; to learn about other Contract
Tools prerequisites, see Section 1.10, “Prerequisites for Installing Contract Tools” on page 12.)

What you should do: Disable add-ins that require .NET Framework 3.5 or earlier. The
documentation for your add-ins should specify which version of .NET Framework they require.
To learn how to disable a Word add-in, see Section 16.22, “Disabling Word Add-Ins” on page 74.
As an alternative, contact the developers of these add-ins and ask them to update their add-ins
to require .NET Framework 4 or later.

If Word temporarily becomes unresponsive when quitting on a computer with a touchscreen or
a stylus, see Section 16.18, “Quitting Word Takes a Long Time on a Computer with a
Touchscreen or Stylus” on this page.

16.20 Contract Tools Won’t Install Updates
What happens: When you click “Check for Updates” in the Subscription view, this alert
message appears: “Checking for Updates - Access is denied.”
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What this means: Most likely, your system administrator used an administrator account to
install Contract Tools for everyone who uses your computer, and your account does not permit
updating Contract Tools when it’s installed in this way.

What you should do: Ask your system administrator to update Contract Tools using an
administrator account. Installation resources are available at
https://papersoftware.com/support.

To learn more about updating Contract Tools, see Section 1.9, “Updating Contract Tools” on
page 11.

16.21 Finding Information about Your Computer
To help you resolve an issue with Contract Tools, we may need information about your
computer and the software you use.

To learn how to find information about this Go to

Windows Section 16.21.1, “Finding Windows Version
Information” on this page

Word Section 16.21.2, “Finding Word Version
Information” on this page

Contract Tools Section 16.21.3, “Finding Contract Tools’ Version
Number” on the next page

Other Word add-ins Section 16.21.4, “Finding Information about Other
Word Add-Ins” on the next page

16.21.1 Finding Windows Version Information
You can find information about your version of Windows.

Windows 10 and later: Open Settings and choose System > About.

Windows 8.1: Open Settings and choose Change PC settings > PC and devices > PC info.

Any version of Windows: Open Control Panel and choose System and Security > System.

16.21.2 Finding Word Version Information
You can find information about your version of Word.

Word 2013 and later (including Word for Microsoft 365):

1. To find the version number, choose File > Account.

2. To confirm whether you use the 64-bit or 32-bit version of Word, click the About Word button;
64-bit or 32-bit appears at the top of the About Microsoft Word dialog.

Word 2010:

• Choose File > Help. The version number and 64-bit or 32-bit appears below About Microsoft
Word.

Word 2007:

1. Click the Office button at the top left of the Word window, and then click Word Options at the
bottom right of the menu that appears.
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2. Click Resources on the left of the Word Options dialog. The version number appears below
“about Microsoft Office Word 2007”. (The 32-bit version of Word 2007 is the only one
available.)

16.21.3 Finding Contract Tools’ Version Number

You can find Contract Tools’ version number.

Here are ways to find Contract Tools’ version number:

• Show the Contract Tools pane, and then click the Subscription button. Contract Tools’ version
number appears at the bottom of the Subscription view.

• Open Control Panel, click “Uninstall a program” at the bottom left, and then find Paper
Software Contract Tools in the list of programs. Contract Tools’ version number appears in the
Version column.

16.21.4 Finding Information about Other Word Add-Ins

You can find information about other Word add-ins.

To show a list of Word add-ins:

• Choose File > Options > Add-ins to show the Add-ins pane of Word Options.

More information about add-ins (like version numbers) may be available in Control Panel.

To find more information about a Word add-in:

• Open Control Panel, click “Uninstall a program” at the bottom left, and then examine the
add-in’s entry in the list of programs.

If you use many Word add-ins, creating screenshots of the Add-ins pane and the Control Panel
window may be faster than creating a list of add-ins; search the internet for “Windows
screenshot” to learn how to create screenshots.

16.22 Disabling Word Add-Ins
You can disable Word add-ins.

To disable a Word add-in:

1. Choose File > Options > Add-ins to show the Add-ins pane of Word Options.

2. Find the add-in you want to disable in the table that appears, examine its entry in the Type
column, and then choose the suitable option from the Manage pop-up menu at the bottom of
the Add-ins pane. For example, choose COM Add-ins if COM Add-in appears in the Type
column, and choose Templates if Template appears in the Type column. Click Go.

3. Use the controls in the dialog that appears.
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Appendix A

Finding Amounts of Money

Learn detailed information about the currencies you can find
using the money token.

You can use the money token to find dollars (for example, 1 dollar and 10 dollars), cents (for
example, 1 cent and 10 cents), and amounts of money denominated with a dollar sign ($).

You can also use money to find amounts of money denominated in the following currencies:

Currency Symbol ISO 4217 code For example

Argentine peso AR$, Ar$ ARS AR$100
100 Argentine pesos
100 Argentinian pesos
100 ARS
ARS 100

Australian dollar A$, AU$, Au$ AUD A$100
AU$100
100 Australian dollars
100 AUD
AUD 100

Brazilian real R$ BRL R$100
100 Brazilian reais
100 Brazilian reals
100 BRL
BRL 100

British pound sterling £ GBP £100
100 pounds
100 British pounds
100 pounds sterling
100 GBP
GBP 100
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Currency Symbol ISO 4217 code For example

Canadian dollar C$, CA$, Ca$, CAN$,
Can$, CDN$, Cdn$

CAD C$100
Can$100
CDN$100
100 Canadian dollars
100 CAD
CAD 100

Chilean peso CH$, Ch$ CLP CH$100
100 Chilean pesos
100 CLP
CLP 100

Chinese renminbi yuan ¥, RMB CNY ¥100
RMB 100
100 Chinese yuan
100 renminbi
100 renminbi yuan
100 yuan
100 yuan renminbi
100 CNY
CNY 100

Czech koruna Kč CZK 100 Kč
100 Kc
100 Czech korunas
100 Czech korunys
100 CZK
CZK 100

Danish krone kr, DKr DKK kr100
100 DKr
100 Danish krone
100 Danish kroner
100 DKK
DKK 100

Egyptian pound £E, E£, LE EGP £E100
E£100
LE100
100 Egyptian pounds
100 EGP
EGP 100

Euro € EUR €100
100 euros
100 EUR
EUR 100
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Currency Symbol ISO 4217 code For example

Georgian lari ₾,ლ GEL ₾100
ლ100

100 Georgian lari
100 GEL
GEL 100

Hong Kong dollar HK$, H.K.$ HKD HK$100
100 Hong Kong dollars
100 HKD
HKD 100

Hungarian forint Ft HUF 100 Ft
100 forints
100 HUF
HUF 100

Indian rupee ₹, ₨ INR ₹100
₨100
100 Indian rupees
100 INR
INR 100

Indonesian rupiah Rp IDR Rp100
100 Indonesian rupiahs
100 IDR
IDR 100

Israeli new shekel ₪, NIS ILS ₪100
NIS 100
100 shekels
100 new sheqels
100 new Israeli shekels
100 Israeli new shekels
100 sheqalim
100 ILS
ILS 100

Japanese yen ¥ JPY ¥100
100 Japanese yen
100 yen
100 JPY
JPY 100

Kenyan shilling KSh KES KSh100
K. Sh. 100
100 Kenyan shillings
100 shillings
100 KES
KES 100
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Currency Symbol ISO 4217 code For example

Malaysian ringgit RM MYR RM100
100 Malaysian ringgits
100 MYR
MYR 100

Mauritian rupee ₨ MUR ₨100
100 Mauritian rupees
100 MUR
MUR 100

Mexican peso MEX$, Mex$ MXN Mex$100
100 Mexican pesos
100 MXN
MXN 100

New Zealand dollar NZ$, N.Z.$ NZD NZ$100
100 New Zealand dollars
100 NZD
NZD 100

Nigerian naira ₦ NGN ₦100
100 Nigerian naira
100 NGN
NGN 100

Norwegian krone kr, NKr NOK kr100
100 NKr
100 Norwegian krona
100 Norwegian krone
100 Norwegian kroner
100 Norwegian kronor
100 NOK
NOK 100

Pakistani rupee ₨ PKR ₨100
100 Pakistani rupees
100 PKR
PKR 100

Philippine peso ₱, PhP, Php, P$ PHP ₱100
P$100
100 Philippine pesos
100 Philippine pisos
100 PHP
PHP 100

Polish złoty zł PLN 100 zł
100 zl
100 zlotys
100 złotys
100 PLN
PLN 100
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Currency Symbol ISO 4217 code For example

Qatari riyal QR QAR QR100
100 riyals
100 QAR
QAR 100

Romanian leu L RON L100
100 leus
100 lei
100 RON
RON 100

Russian ruble ₽, руб, PP, pp, P, p, RR,
rr, Rub, rub

RUB ₽100
100 руб
100 RR
100 rubles
100 roubles
100 RUB
RUB 100

Saudi riyal SR SAR SR100
100 Saudi riyals
100 Saudi Arabian riyals
100 SAR
SAR 100

Singapore dollar S$ SGD S$100
100 Singapore dollars
100 SGD
SGD 100

South African rand R ZAR R100
100 rand
100 ZAR
ZAR 100

South Korean won ₩ KRW ₩100
100 Korean won
100 KRW
KRW 100

Swedish krona kr, SKr SEK 100 kr
100 SKr
100 Swedish krona
100 Swedish kronor
100 SEK
SEK 100

Swiss franc FR, Fr, SFR, SFr CHF Fr100
SFr 100
100 Swiss francs
100 CHF
CHF 100
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Currency Symbol ISO 4217 code For example

Taiwan new dollar NT$, N.T.$ TWD NT$100
100 New Taiwan dollars
100 Taiwan new dollars
100 Taiwan dollars
100 TWD
TWD 100

Thai baht ฿ THB ฿100

100 Thai bahts
100 THB
THB 100

Turkish lira ₺, TL TRY ₺100
100TL
100 Turkish lira
100 TRY
TRY 100

Ukrainian hryvnia ₴, грн, hrn UAH ₴100
100 грн
100 hrn
102 hryvni
100 hryven’
100 UAH
UAH 100

United Arab Emirates
dirham

DH, Dh, dh AED Dh 100
100 dh
100 dirhams
100 AED
AED 100

United States dollar US$, U.S.$ USD US$100
U.S.$100
100 US dollars
100 U.S. dollars
100 United States dollars
100 USD
USD 100

To learn more about finding text, see Chapter 12, “Finding Text” on page 48.
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Appendix B

Configuring iManage Software

Learn about compatibility with iManage Office integrations.

An issue with iManage Integration for Office, a Word add-in distributed with some versions of
iManage FileSite and DeskSite, can cause Word to temporarily become unresponsive when
documents close while using Contract Tools. A solution is available in versions of iManage
Integration for Office distributed with FileSite and DeskSite 9.3.5 and later.

When a document closes, iManage Integration for Office sets the property of a range (similar to
a selection in Word) to the property’s current value. In computer programming, this is called a
self-assignment. A self-assignment typically has no effect, but in this case, it causes Word to
perform a time-consuming and unnecessary task with data that Contract Tools uses to sync
analysis results with documents while there are unanalyzed changes. As a result, Word may
temporarily become unresponsive.

iManage tracks this issue using reference number NT-72170. For more information, see Quick
Update CSAR-2626 for FileSite and DeskSite 9.3.5 with Office Integration, available at
https://imanage.com.

With versions of iManage Integration for Office distributed with FileSite and DeskSite 9.3.5 and
later, you can resolve this issue by creating this Registry value:

Name Type Data

RemoveRangeSelfAssignment REG_SZ Y

You create this Registry value in the HKEY_LOCAL_MACHINE hive. The key path of this
Registry value depends on whether you use 64-bit or 32-bit software.

• If you use the 64-bit version of Windows with 64-bit versions of iManage software, or
the 32-bit version of Windows with 32-bit versions of iManage software, the key path is
SOFTWARE\Interwoven\WorkSite\8.0\Integration\Options.

• If you use the 64-bit version of Windows with 32-bit versions of iManage software, the
key path is SOFTWARE\WOW6432Node\Interwoven\WorkSite\8.0\Integration\Options.

See Section 16.21.1, “Finding Windows Version Information” on page 73 to learn how to find
information about your version of Windows.
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Here are ways to create a Registry value:

• Use Registry Editor; visit Open Registry Editor in Windows 10 (https:
//support.microsoft.com/en-us/help/4027573/windows-open-registry-editor-in-windows-10)
to learn more.

• Use a file with the .reg filename extension (known as a REG file, Registry Entry file, Registry
Entries file, Registration Entry file, and so on). For example, create a file named
iManageRemoveRangeSelfAssignment.reg with the following contents:

Windows Registry Editor Version 5.00

[HKEY_LOCAL_MACHINE\SOFTWARE\Interwoven\WorkSite\8.0\Integration\Options]
"RemoveRangeSelfAssignment"="Y"

Then, double-click iManageRemoveRangeSelfAssignment.reg in File Explorer to create a
Registry value. Visit How to add, modify, or delete registry subkeys and values by using a .reg file
(https://support.microsoft.com/en-us/help/310516) to learn more.

• Use PowerShell or Command Prompt. For example, enter in PowerShell:

$keyPath = 'HKLM:\SOFTWARE\Interwoven\WorkSite\8.0\Integration\Options'
if (!(Test-Path $keyPath)) { New-Item $keyPath -Force }
New-ItemProperty $keyPath RemoveRangeSelfAssignment -Value Y -Force

or in Command Prompt:

set keyPath=HKLM\SOFTWARE\Interwoven\WorkSite\8.0\Integration\Options
reg add %keyPath% /v RemoveRangeSelfAssignment /d Y /f

If you use versions of iManage Integration for Office distributed with FileSite and DeskSite 9.3.4
or earlier, see Section 16.16, “Closing a Document Takes a Long Time When Using Multiple
Add-Ins” on page 70 for alternatives to creating a Registry value.
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Index

A
analysis settings

exporting, 24
for defined terms, 28
for drafting errors, 37
for tables, 25
importing, 24
saving with documents, 23

Analyze button, 14, 20, 22
analyzing

generally, 21
part of document, 20, 23, 49, 68
tables, 25, 68
updating analysis, 14, 20, 22, 56
when using Track Changes, 24

ancillaries
copying list of, 19, 46
finding, 45, 49
highlighting, 15
ignoring, 24, 45
navigating, 17, 45

Ancillaries view, 17, 19, 45

B
Back and Forward buttons, 14, 15
building blocks, 55, 69, 71

C
Clear button, 14
Completion menu, 16, 31, 54
Context button, 15, 17
Contract Tools

activating, 8, 65, 66
connecting to license server, 10, 67
deactivating, 57, 65
disconnecting from license server, 58
enabling, 11, 62
installing, 7, 61, 62
preferences, see preferences
prerequisites, 12, 61

removing fromWord, 59, 63
subscription management, 58
troubleshooting, 60
trying, 7, 65, 66
turning on or off, 14, 56
tutorial, 11
uninstalling, 59
updating, 11, 72
using on virtual machines, 9
version number, 74

Contract Tools Help, 14
Contract Tools License Server

connecting to, 10, 67
disconnecting from, 58

Contract Tools pane
copying contents of, 18
showing and hiding, 14, 16, 56
views, 14, 18

Contract Tools ribbon tab, 13
copying

ancillaries, 46
cross-references, 27
defined terms, 31
drafting errors, 42
generally, 18
provisions, 27
search results, 48
to-dos, 44
with page numbers, 19

cross-references
converting text to fields, 17, 33
copying, 27
finding, 32, 49
highlighting, 15
navigating, 15, 17, 32
to unknown items, 19, 33

Cross-References view, 17, 32

D
defined terms
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analysis settings, 28
completing uses of, 16, 31
copying list of, 19, 31
finding, 28, 68
finding uses of, 17, 30
highlighting, 15
ignoring, 24, 31
including from another document, 30, 68
navigating, 15, 17, 30
singular and plural forms of, 40

Defined Terms view, 17, 19, 30
drafting errors, see proofreading
Drafting Errors view, 17, 19, 41

E
errors, see proofreading

F
finding

amounts of money, 17, 50, 75
any word, 51
dates, 17, 50
durations, 17, 50
numbers, 50
times of day, 17, 51
units of time, 51
words and phrases, 48

Forward button, 14, 15

H
Help button, 14
highlighting

amounts of money, 15
ancillaries, 15
cross-references, 15
dates, 15
defined terms, 15
drafting errors, 16, 41
durations, 15
inline lists, 15
parentheses, 16
placeholders, 15
proviso lists, 15
search results, 16
times of day, 15

history, see navigation history

I
inline lists

finding, 47, 49
highlighting, 15
markers, 15, 32, 36, 47, 49

Issues pop-up menu, 19, 41, 56

N
navigating

ancillaries, 17, 45
by double-clicking text, 15
cross-references, 15, 17, 32
defined terms, 15, 17, 30
drafting errors, 17, 41
history, 14, 15
placeholders, 17
provisions, 26
search results, 48
to related items, 35
to similar items, 15, 17
to-dos, 44

navigation history
clearing, 14
going back or forward in, 14, 15

Next button, 15, 17, 41

O
On / Off button, 14

P
placeholders, see also to-dos

generally, 43
highlighting, 15
navigating, 17

preferences
analysis, 22–24, 56, 71
Completion menu, 16
Contract Tools, 56
Contract Tools pane, 56
generally, 56
highlighting, 16, 56
Issues pop-up menu, 19, 56
navigation, 14, 15
restoring defaults, 63
snippets, 54–56, 69, 71

Preferences view, 56
Previous and Next buttons, 15, 17, 41
proofreading

analysis settings for drafting errors, 37
copying list of drafting errors, 19, 42
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highlighting drafting errors, 16, 41
ignoring capitalized words and phrases

while proofreading, 37
ignoring drafting errors, 17, 24, 41
kinds of drafting errors found, 36
navigating drafting errors, 17, 41
restoring ignored drafting errors, 42

Protected View, 11
provisions

copying cross-reference to, 27
copying list of, 19, 27
finding, 26, 49, 68
navigating, 26
numbers, 26, 27, 32, 36, 49
titles, 26, 27, 36, 40

Provisions view, 19, 26
proviso lists

finding, 47, 49
highlighting, 15
markers, 15, 47, 49

R
Related Items view, 35

S
scrolling, 14
search results

copying list of, 19, 48
highlighting, 16
navigating, 48

Search view, 17, 19, 48
searching, see finding
snippets

and building blocks, 55, 69, 71
categories of, 55
comparing to text, 55
completing, 16, 54
creating, 54, 69
deleting, 54, 56
editing name of, 54
inserting, 54

snippets file, 69
Snippets view, 53, 71
subscription, 58

T
tables, 25, 68
to-dos

copying list of, 19, 44
finding, 43
navigating, 44

To-Dos view, 17, 19, 43
Track Changes, 24

U
underlining, see highlighting

V
virtual machines, 9
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